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Important glossary defined in PCM370 

Analog Channel: A type of channel to get device channel measure data. 

Digital Channel: A type of channel to get device channel status information. 

PCM Explorer: The PCM Explorer is a presentation of the currently selected route about machine 

train, machine, and measurement point. The PCM Explorer contains Tree View and Graphics View. 

Tree View: It is the tree type listing of the components in the PCM370-CFG software to display the 

route of three hierarchy layers: Machine-train, Machine, and Measurement-point. 

Node: It is the general description for the item in the Tree View to indicate a Machine-train, a 

Machine, or a Measurement-point. 

Graphics View: It is a type of picture view in PCM370-CFG software and PCM370-RUN software 

to display pictures of machine train, machine and measurement points. In Graphics View, you can 

view real time measure value of each measurement point channel, and you can also view the alarm 

status of the machine train, machine and measurement points. 
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PCM370 Introduction 

Introduction 
PCM370 is a plant condition monitoring system that collects, stores, analyzes and distributes the 

machinery status monitoring information. It can obtain status data of critical machinery. All of 

ProvibTech’s digital monitoring systems can be quickly and easily integrated into the PCM370 system, as 

well as devices from other manufactures’ which communicate via Modbus. Besides the vibration 

monitoring data, the PCM370 is also capable of collecting numerous process variables such as: voltage 

inputs, RTDs, thermocouples, discrete inputs and Modbus. 

 

Features 
 Integrate all of machine running monitoring data into one system 

 Measures static variables and process variables* 

 Integrates process inputs 

 User friendly system with touch panel 

 ProvibTech’s database 

 Software alarms used for indication of machine status 

 Data collection done automatically or with alarm 

 Modbus data collection and storage 

 

PCM370-CFG software 
1. Automatic configuration: All ProvibTech’s digital monitors can be configured by the PCM370-CFG. 

Only a couple clicks of the mouse to setup. 

 DTM 

 PT2060 

 PT580 

 DM200 

 PT371 

2. Ability to interface with other devices which have Modbus interface: Any other manufactures’ 

Modbus device can integrate with the PCM370-CFG. Status and running data are configured 

according to user requirements. 

3. Machine graphical interface: The PCM370-CFG provides a library of machine photos or user may 

import images which can be used for the machine status display. 

4. The following are configurable: 

 Data mapping by machines: 
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 Trend-history (chart list recorder) 

 Trend-real time 

 Alarms with PT373 mapping 

 4-20mA with PT372 mapping 

 Software program runs on PCM370-TOUCH or any standard PC. 

 

PCM370-RUN software 
The user interface that displays the machine condition graph is included in the PCM370-RUN. Data is 

obtained from ProvibTech’s database. 

1. Hardware interface: 

 ProvibTech’s digital monitors (Modbus RTU) 

 Other manufactures’ equipment (Modbus RTU capable devices) 

 RTU, thermocouple inputs 

 Current and voltage inputs 

2. Standard condition monitoring plot: 

 Machine-train graphical interface with real-time status 

 Machine graphical interface with real-time measurement point overall and status 

 Trend plot of history data with single or multiple points (up to 100 per data series) 

 Real-time alarms, alarm list 

 Real-time overall vibration and status table view 

 Bar graph of 24 channels 

 Real-time trend plot, simulate recorder 

 Print any viewing window 

3. Measurement range: 

 Acceleration (pk or RMS): 0~20g 

 Velocity (pk or RMS): 0~200 mm/sec (0~8 in/sec) 

 Displacement (pk-pk): 0~100 mm (0~4 in) 

4. Units of measurement: 

 Peak 

 Peak to peak 

 RMS 

 Average 

5. Route can be configured to three hierarchy layers: 

 Machine-train 

 Machine 

 Measurement-point 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

7 
 
 
 

 

 

6. Storage and network databases: 

 ProvibTech’s database 

7. Data storage capacity: 

 Limited by hardware storage capacity 

 Unlimited by software 

8. Routing capacity: Unlimited in machine-train, machine, and machine-point 

9. Modbus interface: 

 Works with all ProvibTech’s digital monitors: PT2060, DTM, DM, PT580, PT371, PT372, and 

PT373 

 Works with any other vendors’ Modbus RTU 

10. Bar graph: 

 Each channel accepts up to 16 status parameters; such as OK, Alert, Danger, Trip-multiply, etc. 

This information is user-configurable. 

11. Printer support: Each graph can be printed. 

 

Running Environment 
Minimum system requirement: 

Operation System: Windows XP or Windows2000 

CPU: P4 2.0 GHz 

Memory: 512MB 

Hard Disk: 40G 

Display: VGA or Touch Panel 
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PCM370 Quick Start Guide 

NOTE: You are recommended to read Important glossary defined in PCM370 on User Manual before 

using this Quick Start Guide. 

 

1. System Wiring 

Wire you PCM370 system. You can refer to Field Wiring Diagram on page 10 of the User Manual. 

 

2. PCM370 Installation 

1) Install PCM370 software on the computer. You can refer to page 16 of the User Manual. 

2) If your system uses USB-RS232 Converter, you should install USB-RS232 Converter driver on the 

computer, and if your system uses USB-RS485 Converter, you should install USB-RS485 Converter 

driver on the computer. You can refer to page 13 of the User Manual. 

 

3. System Configuration 

1) Run PCM370-CFG software. Default user name: administrator; Default Password: password.  

2) Add devices. You can refer to page 42 of the User Manual. 

For DAQ devices (such as DTM, PT580, DTM200) that upload both measure value and status 

information, you should set the channel number two times as the actual number of the used channels. For 

DAQ devices (such as PT371) that only upload measure value, you should set the channel number 

equaling the actual number of the used channels. For other 4-20mA (such as PT372) and relay (such as 

PT373) devices, you should set the channel number equaling the actual number of the used channels. 

3) Configure channels of DAQ devices. You can refer to page 49 of the User Manual. 

4) Add machine trains. You can refer to page 38 of the User Manual. 

5) Add machines. You can refer to page 40 of the User Manual. 

6) Add measurement points. You can refer to page 41 of the User Manual. 

7) Map DAQ device to machine trains. You can refer to page 53 of the User Manual. 

8) Map DAQ device channel to measurement point’ channel. You can refer to page 54 of the User 

Manual. 

9) Set dynamic data collection conditions for machine trains. You can refer to page 66 of the User 

Manual. 

10) Calibrate DAQ device channels. You can refer to page 67 of the User Manual. 

 

Continues the steps below if you system contains 4-20mA module and relay module. 

 Configure 4-20mA current output devices. You can refer to page 58 of the User Manual. 

 Configure relay devices. You can refer to page 60 of the User Manual. 
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11) Define PCM Explorer. You can refer to page 29 of the User Manual. 

12) Edit picture for machines and measurement points. You can refer to page 32 of the User Manual. 

13) Set system unit and trend depth. You can refer to page 38 of the User Manual. 

14) Define custom trend plot type. You can refer to page 63 of the User Manual. 

15) Quit from PCM370-CFG software. 

 

4. Run PCM370-RUN software. Default user name: administrator; Default Password: password. 

 

For more detailed information about each step, you should refer to the related chapters on 

User Manual. 
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PCM370 Installation 

Field Wiring Diagram 

Field Wiring Diagram 1-PCM370 with DTM/DM200/PT580 via Modbus RTU 
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Field Wiring Diagram 2-PCM370 with PT371 via Modbus RTU 
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Field Wiring Diagram 3-PCM370 with PT372 via Modbus RTU 

 
 

Field Wiring Diagram 4-PCM370 with PT373 via Modbus RTU 
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Field Wiring Diagram 5-PCM370 with Modbus TCP Server Device via Modbus TCP Client 
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Load USB-RS232 or USB-RS485 Converter driver (For Window XP) 

a. Connect the device to a spare USB port on your computer. Windows Found Hardware Wizard will be 

launched. 

 

b. Select “No, not this time” from the options available and then click “Next” to proceed with the 

installation.  

 

c. Select “Install from a list or specific location (Advanced)” as shown above and then click “Next”. In 

below window, select the proper option according to instruction in the window. And then click 

“Next” button. 
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d. Click on “Continue Anyway” to continue with the installation. 

 

e. The following screen will be displayed as Windows XP copies the required driver files. 

 

f. Click “Finish” to complete the installation. 
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g. After clicking Finish, the Found New Hardware Wizard will continue by installing the COM port 

emulation driver. The procedure is the same as that above for installing the serial converter driver.  

Open the Device Manager (located in Control Panel\System then select the Hardware tab and 

click Device Manger) and select Devices by Type from View menu. The device appears as an 

additional COM port with the label USB Serial Port.  
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Installing PCM370 

Put the installation CD into CD-driver, supposing that the CD-driver is G and then double-click file of 

Setup.exe in directory of “G:\PCM370-Setup” to start this installation program. 

1. Show welcome information. Click Next to continue. 

 
2. Click Browse…button to select a destination folder or use the default folder. Then click Next to 

continue. 

 
3. Show current settings about copying files. Click Next to continue. 
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4. Show copying status window.  

 
If you see Locked File Detected window in the process of copying files (see below picture), please check option 

of “Don’t display this message again”. 

 
And then click Ignore button. See below: 
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5. Installation complete. Click Finish. 

 
 

Uninstalling PCM370 

There are two methods for you to uninstall PCM370 System. 

Method 1: Directly select All Programs, PCM370, Uninstall; 

Method 2: Select All Programs, Control Panel, Add or Remove Programs to open the Add or Remove 

Programs window. Select PCM370 in Change or Remove Programs tab, and click Change/Remove 

button. 
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Click OK button in following picture: 

 
Show uninstalling status window: 

 
If you see Locked File Detected window in the process of copying files (see below picture), please check option 

of “Don’t display this message again”. 
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And then click Ignore button. See below: 

 
Un-installation process completes. Click Finish. 
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PCM370-CFG Software Operation 

Start PCM370-CFG Software 

There are two methods for you to start PCM370-CFG software: 

Method 1: Select Start, All Programs, PCM370, PCM370-CFG;  

Method 2: Directly double-click shortcut icon of PCM370-CFG on the desktop; 

The login window is below: 

 

Enter User Name and Password in the related edit boxes, and then click OK to log on. If you are the first 

time to log on, you can use the default user name and default password. The default user name is: 

administrator; the default password is: password. You are strongly recommended to change the 

password after logon by selecting Modify Password from User menu. 
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Toolbar 

The toolbar of PCM370-CFG software is below: 

 

: Open an existed database file which is called “Vibrate”. As an alternative to this operation, you can 

select Open DB from File menu. 

: Backup a database file which is called “Vibrate”. As an alternative to this operation, you can select 

Backup DB from File menu. 

: Restore the current database file which is called “Vibrate”. As an alternative to this operation, you 

can select Restore DB from File menu. 

: Open Define PCM Explorer window. As an alternative to this operation, you can select Define PCM 

Explorer from Edit menu. 

: Refresh PCM Explorer. As an alternative to this operation, you can select Refresh PCM Explorer 

F5 from User menu. 

: Edit picture for machine trains, machines and measurement points. As an alternative to this operation, 

you can select Edit Picture from Edit menu. 

: Display About PCM370-CFG Window. As an alternative to this operation, you can select About 

PCM370-CFG from Help menu. 
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File Menu 

 
 

Open DB 

Use this command to select a specified path in which the pre-defined database file “Vibrate” saves. 

NOTES: 

 Information about users, machine-trains, machines, measurement-points and devices is saved in 

Vibrate.  

 Only administrator and Super User can open, backup, restore and delete database. 

 User can only open the database that records the user information of this user. 

 For the administrator and Super User, if file “Vibrate” is saved in path of “E:\ProvibTech\PCM370”, 

they should select the path as “E:\ProvibTech \PCM370\Vibrate”. 

 
 

Backup DB 

Use this command to backup the current database. Select Backup DB from File menu and then select a 

backup path. See below: 
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In precondition that you are an administrator or a super user, if you select a directory of 

“D:\ProvibTech\PCM370”, this database file will save as “E:\ProvibTech\PCM370\Vibrate”. 

 

Restore DB 

Use this command to restore the current database to a backup database. Select Restore DB from File 

menu, and then select a path in which the pre-defined database file is saved. If there is a vibrate file under 

path of “C:\ProvibTech\PCM370”, you should select the path as “C:\ProvibTech\PCM370\vibrate”. 
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Delete DB Data 

Use this command to launch Delete DB Data window. In this window, you can delete data of a channel or 

several channels from the current database. Even you can empty the current database. See below: 

 
Device Name: Select a device from this list and then all channels under this device are displayed. 

Channel Name: List all channels under the selected device. If you check the check box before a channel, 

this channel is selected. 

Select All: Check this button to select all channels in the channel list. 

Delete Data: Click this button to delete data of the selected channels. 

Delete DB Data: Click this button to empty the current database. After the operation, all data in the 

database is deleted. 
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User Menu 

 
 

User Management 

NOTE: 

There are three levels of users in the PCM370: administrator, Super User and User. The administrator has 

full access to operate PCM370-CFG software. Super Users almost have full access to PCM370-CFG 

software. But as Super User, they can’t manage users such as adding users, changing users’ information, 

and deleting users. Users only have part of access to PCM370-CFG software. As User, they can set 

information that is related to themselves such as changing logon password, defining PCM Explorer, setup 

system information, customizing trend type...etc. They also can view all lists and plots in their PCM 

Explorer. But they can’t configure the system information.  

 

Users that log on by account of administrator can use this command to launch User Management window. 

 
 

Add…button: 

Click this button to add a new user. Enter the user name, password in the related edit boxes. And select the 

user level for the new user. Finally, click OK to save the operation. 
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Modify…button 

Use this command to change information of the selected user. Select a user name in user list first, and then 

click Modify button.  

 
In above window, you can change name, logon password, and account level of the selected user. Finally, 

click OK to save the information. 

 

Delete…button 

Use this command to delete the user from PCM370 system. Select the user from the user list first and then 

click Delete button. If you are sure to delete this user, you should click Yes on below window. 

 
 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

28 
 
 
 

 

 

Modify Password 

Use this command to change logon password of the current user. You are required to enter the new 

password twice in below window. 

 
 

Refresh PCM Explorer F5  

Use this command to refresh the current PCM Explorer. Pressing F5 on the keyboard is an alternative to 

this operation. 
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Edit Menu 

 
 

Rename 

This command is used to rename the machine train, machine, or measurement point in the PCM Explorer 

of the current user. 

Left click a machine train, or a machine, or a measurement point in the tree view, and then select Rename 

from Edit menu. Rename window is launched. Enter the new name for the selected node and finally click 

OK. 

 
As an alternative to this operation, you can right click this node in the tree view, and then select Rename 

from drop down menu. 

 
NOTE: After you finish the operation of renaming, you should select Refresh PCM Explorer from User 

menu to refresh the current PCM Explorer.  

 

Define PCM Explorer 

Usually there are several machine trains monitored by PCM370 system, but you may be only concerned 

about some machine trains, so it’s no need for you to know the running status of all machine trains. In this 
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condition, you can use Define PCM Explorer command to select the machine trains you are concerned 

about and add them in your PCM Explorer. 

Below is the Define PCM Explorer Window. 

 
Selected Machine Train: List the machine trains that will be displayed on the current PCM Explorer. 

Available Machine Train: List the machine trains that are monitored by PCM370 System but haven’t 

been selected to the current PCM Explorer. 

<<: Left shift button. 

>>: Right shift button. 

 

Delete 

This command is used to delete a machine train or a machine or a measurement point from PCM Explorer 

of the current user. 

Left click a machine train, or a machine, or a measurement point in the tree view, and then select Delete 

from Edit menu. The node you selected is deleted directly from PCM Explorer. 

As an alternative to this operation, you can right click this node in the tree view, and then select Delete 

from drop down menu. 

 
 

NOTE: If you use this command to delete a node, this node is only deleted from the current PCM Explorer 

and it is still monitored by PCM370 system. Following instructions teach you how to re-display them in 

the PCM Explorer. 

Condition 1: If the node you deleted is a machine-train: for example, the node is Train Demo. 

Step1: Select Define PCM Explorer from Edit menu. You will find Train Demo has already been listed in 

Available Machine Train List. 
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Step2: Left click Train Demo and click << to move it to Selected Machine Train List. Finally, click OK 

button. 

Condition 2: If the node you deleted is a machine or a measurement point: for example, the node is 

DTM20_101. In this example, DTM20_101 is a machine that belongs to Train Demo. DTM20_101 has 

already been deleted from PCM Explorer. 

Step1: Select Define PCM Explorer from Edit menu. The machine train that contains the deleted node is 

still listed in Selected Machine Train List. 

 
Step2: Left click Train Demo in Selected Machine Train List and click >> to move it to Available Machine 

Train List. And then click OK button. 

Step3: Repeat Step1. 
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Step4: Left click Train Demo in Available Machine Train List and click << to move it to Selected Machine 

Train List. Finally, click OK button. 

 

Edit Picture 

This command is used to edit pictures of machines and measurement points in your PCM370 system. With 

this command checked, you can change picture location of machines and measurement points on Graphics 

View, zoom in or zoom out the machine pictures, link machine and machine as well as machine and 

measurement points. 

Following lines give you an example to show how to use this command and what functions this command 

provides. Below table gives the relationship between machine train, machine, and measurement point. 

Machine Train Machine Measurement Point 

Train Demo DTM20_101 Velocity 

Train Demo DTM10_302 Displacement 

 

After you finished adding Train Demo, DTM20_101, Velocity and Displacement, you should select 

Define PCM Explorer from Edit menu and display Train Demo in your PCM Explorer. The PCM 

Explorer is below: 
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Step1: Select Edit Picture from Edit menu to check it. See below: 

 
Step2: Set location of pictures on Graphic View. Drag picture of DTM20_101, DTM10_302, Velocity, 

and Displacement to a proper location in Graphic View. 
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Step3: Create the relationship between machine and machine. Right click picture of DTM10_302, and 

then select Link Machine from drop down list.  

 
If you want to link machine DTM10_302 and DTM20_101, you can click any place on the picture of 

DTM20_101. The line begins with picture of DTM10_302 and ends with picture of DTM20_101. 
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Step4: Create the relationship between machine and measurement point. Right click picture of Velocity 

and then select Stud on Machine Picture from drop down list. 

 
Since Velocity belongs to DTM20_101, left click the proper place on picture of DTM20_101. Now you 

have linked Velocity with DTM20_101. Repeat the step to link Displacement with DTM10_302. The 

result after the operations is below: 
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Step5: After you finish all operations above, you should select Edit Picture from Edit menu again to 

make the command unchecked. 

 

NOTES: 

All operation below is in condition of Edit Picture command from Edit menu is checked. 

 Zoom in and zoom out machine pictures 

Condition 1: 

Double clicking a machine picture will display Graphics View of machine and the related measurement 

points. The machine picture will be shown in middle of Graphics View and is magnified to a certain size. 

Double clicking this machine picture again will restore the machine picture to original size. 
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Condition 2: 

Left click a machine picture and rest your mouse pointer on the edge of this picture, if you see the straight 

double-arrow, you can drag this picture to zoom in or zoom out it. You can drag the picture from four sides 

of this picture: up, down, left, and right. If you want to zoom in the picture, you can drag it to outside 

direction; and if you want to zoom out the picture, you can drag it to inside direction. 

 

 Remove the linking line between machine and machine 

In above example, we have linked DTM20_101 with DTM10_302. The line begins with DTM20_101 and 

ends with DTM10_302. Right click picture of DTM20_101, and then select Link Machine from drop 

down list. Finally, left click any place outside the picture of DTM10_302. 
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Setup Menu 

 
 

System Setup 

In System Setup Window you can set unit and trend depth. 

 
Trend depth is the maximum number of the points to generate a trend plot. The maximum value is 2000. 

 

Machine Train Setup 

Machine Train Setup Window is used to add, modify, and delete machine train. 
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Add…button: 

Click this button to add a new machine train. 

 
Enter the name in the edit box and click Select Picture to specify a picture for this machine train. 

 

Modify…button 

Select the machine train from Machine Train List and then click this button to change machine train 

information. You can change the machine train name or picture. 

 
 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

40 
 
 
 

 

 

Delete…button 

Select the machine train and then click this button to directly delete this machine train from PCM370 

system.  

 

NOTE: Picture only by format of*.bmp is valid. 

 

Machine Setup 

Machine Setup Window is used to add, modify, and delete machine. 

 
 

Add…button 

Select a machine train from the list and then click this button to add a new machine under the selected 

machine train. Enter the name for this machine and then click Select Picture to specify a picture for this 

machine. 

 
 

Modify…button 
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Select the machine from the list and then click this button to change machine information (name or 

picture). 

 
 

Delete…button 

Select the machine and then click this button to directly delete this machine from PCM370 system.  

 

NOTES: 

 Maximum 8 machines are allowed to add under a machine train. 

 Picture only by format of *.bmp is valid. 

 

Measurement Point Setup 

Measurement Point Setup Window is used to add, modify, and delete measurement point. 

 
 

Add…button: 
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Select a machine from the list and then click this button to add a new measurement point under the selected 

machine. Enter the name in the edit box and then click Select Picture to specify a picture for this new 

measurement point. 

 
 

Modify…button 

Select the measurement point from the list and then click this button to change information (name or 

picture) of this measurement point. 

 
 

Delete…button 

Select the measurement point from the list and then click this button to directly delete this measurement 

point from PCM370 system. 

 

NOTE: Picture only by format of *.bmp is valid. 

 

Device Management 

Use this command to launch Device Management window. In this window, you can add new devices, 

change device properties and remove devices from PCM370 system.  
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Name: Display device name. 

Device No.: Display device No.. This number identifies a unique device monitored by PCM370 system. 

PCM370 will assign a No. for device when it is added. User can change device No. The No. range is from 

0 to 63 (0 and 63 are contained). 

Device Type: Display device type. There are two available options for you to select: Modbus TCP Client 

and Modbus RTU. 

Property: There are three available options: DAQ Module, 4-20mA Current Output, Relay Module. 

Channel Number: Display channel number. Channel Number should be integer between 0 and 33 (0 and 

33 are not contained). For a 4-20mA and Relay Module device, the channel number should equal the actual 

number of the used channels. Specially for the DAQ Module device, if it is used to get both measure value 

and status information, you should set the channel number two times as the actual number of the used 

channels; if the device is used only to get measure value, you should set the channel number equaling the 

actual number of the used channels. So for DTM and PT580, in normal condition, the channel number is 

usually set as 2; and for PT371, if the number of the used channels is 16, the channel number should be set 

as 16. 

 

Add…button 

Click this button to add a new device to PCM370 system. 
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Enter information in the related edit boxes. Select device type and device property. For DTM, PT580, 

DM200, and PT371, the device property should be set as DAQ Module; and for PT372, the device 

property should be set as 4-20mA Current Output; and for PT373, the device property should be set as 

Relay Module. 

 

Modify…button 

Select a device from the list and then click this button to launch Modify Device Information window. In 

this window, you are only allowed to change device name. 

 
 

Delete…button 

Select a device from the list and then click this button. If you are sure to delete this device, please click Yes 

on the information window. If you delete the device, all data stored in the device is removed. 
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Extended Definition…button 

Select a device from the list and then this button is enabled. For devices with different types, clicking this 

button will launch different windows. 

 If the device type is Modbus RTU, the window is below: 

 
Channel Definition: 

Double-clicking a channel, following dialog box pops up. Type the proper register address and description 

words. And then click OK button. 

 
Slave Address: A field which allows multiple devices to share the same computer. These devices would 

be connected to the same COM port but would be distinguished by their individual slave address. Slave 

Address is always set by the related configuration software of this device. 

Channel No.: Display channel No.. 

Address: The register address indicates the location in the device where the status and data is read. Please 

refer to Appendix Ⅳ and Appendix Ⅴ of this book to get the channels’ register address of different 

devices. 

Description: Short words to describe this channel. 

 

COM Selection: 

Select an available COM port first. 

Setup (Button): Click this button. Select proper communication parameters and click OK. 
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Click Restore to Default button to set communication parameters to default value. 

 

Auto Scan button: 

1. Before you click this button, you should ensure that device slave address and channel register address 

are correctly set. 

2. Click this button to automatically test the communication between software and hardware device. 

The communication parameters will be refreshed after the scanning. 

 

Connection Testing (Button): 

Before you click this button, you should ensure that device slave address and channel register address are 

set correctly. 

Click this button and Communication window is launched. 

 
Port: List the available COM ports on local computer. 
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Auto by left-hand: Mark it and PCM370 will automatically scan the available COM port on local 

computer. 

Manual by left-hand: Mark it and select a COM port. 

Auto by right-hand: Mark it and PCM370 will automatically scan the proper communication parameters. 

Manual by right-hand: Mark it and manually configure the communication parameters. 

Auto Search (Button): Click this button to start scanning. The result will be shown behind string of 

Current information. If scanning succeeds, all communication parameters will be refreshed automatically. 

And if it fails, the failed window is displayed to inform you. 

 

 If the device type is Modbus TCP Client, the window is below: 

 
Channel Definition: Double-click a channel, following dialog box pops up. Type the proper register 

address and description words. And then click OK button. 

 
Channel No.: Display channel No. list. 

Address: The register address indicates the location in the device where the status and data is read. Please 

refer to Appendix Ⅳ and Appendix Ⅴ of this book to get the channels’ register address of different 

devices. 

Description: Short words to describe this channel.  
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Server Address: IP Address of the Modbus TCP Server device. 

Advanced Setting (Button): Click this button to launch Advanced Setting Window. 

 
Slave Address: Slave address of the third part Modbus TCP Server device. 

Server Port: The port that is used by TCP Client and third part TCP Server to communicate with each 

other. 

 

Connection Testing (Button) 

Before click this button, please ensure that you have finished settings on client device channel and server. 

Clicking this button, PCM370 will automatically test the communication between the client and server. 

The communication result will be launched then. 
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Channel Setup 

Use this command to configure channel information of DAQ devices. 

 
Select Device: Display all DAQ devices in PCM370 system. 

 

Channel Definition…button 

Select a DAQ device and a channel of this device. And then click this button to launch Channel Definition 

Windows. 

 
Device Name: Display the device name. 

Channel No.: Display the channel No. 

Channel Name: Display the channel name. User can enter few words to describe the selected channel. 
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Channel Property: There are two available options: Analog Channel and Digital Channel. Analog 

Channel is used to upload channel measure value and Digital Channel is used to upload channel status 

information. 

Sampling Frequency: It’s the sampling frequency for PT370-RUN software to read device channel data. 

Enable Dynamic Data Collection: If you check this option and the machine train this device channel 

mapped is set Trigger Mode, when this machine train is triggered, the device channel will start dynamic 

data collection. 

 

Analog Channel Setting Tab 

 
Channel Type: Display type of transducer the selected channel maps. There are four available options: 

Acceleration, Velocity, Vibration [from Prox], and Process. 

Measurement Unit: Select an appropriate measurement unit for the variable. 

Measurement Type: There are four available options: PK, PK-PK, RMS, and AVER.  

 PK: Zero to peak value. It is one half of the peak to peak value.  

 PK-PK: Peak to peak value. It is the difference between positive and negative extreme values of a 

signal. 

 RMS: Root Mean Square. It is square root of the arithmetic mean of a set of squared instantaneous 

values. And it is used as a measure of amplitude. For sine wave, RMS equals 0.707 x Peak. (0.707 = 

1/square root of 2). 

Work Frequency: Please enter actual running speed of the machine the current channel maps. 

Full Scale High, Full Scale Low: Please enter maximum and minimum value of full scale range. Full 

scale range defines the entire span of the data to be displayed. A larger range can accommodate a wider set 

of data values. 
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Danger High, Danger Low, Alert High, Alert Low: For channel type of Acceleration, Velocity, and 

Vibration [from Prox], two alarm levels are supported. For channel type of Process, four alarm levels are 

supported. 

 

Digital Channel Setting Tab 

 
Definition: For a digital channel, maximum 16 status bits are allowed to define. If you want to define a bit 

of the digital channel, you should check the check box before this bit in Definition field. 

Alert: If you want to define a bit as Alert status bit, for example, you want to set bit2 as Alert bit, the 

detailed process is below: Check bit2 in Definition field first, then check “Alert”, and finally check bit2 in 

Alert field. When this bit returns 0 or False, it means the status of this bit is normal; when this bit returns 1 

or True, it means the status of this bit is alert. 

Danger: If you want to define a bit as Danger status bit, for example, you want to set bit3 as Danger bit, the 

detailed process is below: Check bit3 in Definition field first, then check “Danger”, and finally check bit3 

in Danger field. When this bit returns 0 or False, it means the status of this bit is normal; when this bit 

returns 1 or True, it means the status of this bit is danger. 

OK: If you want to define a bit as OK status bit, for example, you want to set bit1 as OK bit, the detailed 

process is below: Check bit1 in Definition field first, then check “OK”, and finally check bit1 in OK field. 

When this bit returns 0 or False, it means the status of this bit is normal; when this bit returns 1 or True, it 

means the status of this bit is NOT OK. 

BitDescription: You can enter few words to describe this bit. 

MeaningForFalse: You can enter few words to describe the situation when the bit returns 0 or False. 

MeaningForTrue: You can enter few words to describe the situation when the bit returns 1 or True. 

Trigger: If you check trigger option of a bit, when the bit returns 1 or True, the machine train this channel 

maps will be triggered. Channels that map the triggered machine train and are set “Enable Dynamic Data 
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Collection” will start dynamic data collection. Especially for alert bit and danger bit, the machine train also 

should be set “Alarm Trigger” on Dynamic Data Collection Setup Window. 

Show in Graph: If you check a bit in Show in Graph field and the current digital channel has mapped the 

analog channel, the bit information will be displayed on bar graph and trend plot window. 

 

NOTES: It’s special for all devices of ProvibTech that are monitored by PCM370: 

 Only three bits can be identified by PCM370 system: Alert, Danger and OK. 

 Bit1 should set as OK; bit2 should set as Alert; bit3 should set as Danger; bit4 should set as Bypass; 

bit5 should set as Trip Multiply; bit6 should set as OFF; bit7 should set as GAP OK. 

 
Bit1: OK. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status is 

NOT OK. 

Bit2: Alert. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status is 

Alert. 

Bit3: Danger. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status 

is Danger. 

Bit4: Bypass. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status is 

Bypass. 

Bit5: Trip Multiply. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit 

status is Trip Multiply. 

Bit6: OFF. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status is 

OFF. 

Bit7: GAP OK. When it returns 0 or False, the bit status is normal. When it returns 1 or True, the bit status 

is GAP NOT OK. 
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Map DAQ Device 

Mapping is the process of linking a data source to a measurement point. This process links a monitored 

location on a machine train with hardware device that is actually collecting the data. So before this process, 

we should map the machine train with DAQ device. 

 
Mapping Status:  

If a machine train has mapped DAQ devices, it will show Mapped; and if the machine train hasn’t mapped 

any DAQ device, it will show blank. 

 

Map DAQ Device…button: 

Selecting a machine train that hasn’t mapped any DAQ devices, this button is activated. Click this button 

 
Select the device in Un-mapped Device list and then click << button to move it to Mapped Device. Repeat 

it to map more DAQ devices to the selected machine train. Finally, click OK. 

 

View…button: 

Selecting a mapped machine train, this button is activated. Click this button to launch View window. 
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In this window, you are only allowed to view the mapping condition of DAQ devices (the devices that have 

mapped the selected machine train and devices that haven’t mapped any machine train), but you can’t 

change any information. 

 

Map DAQ Device Channel 

Mapping is the process of linking a data source to a measurement point. This process links a monitored 

location on a machine train with hardware device that is actually collecting the data. 

 

NOTES: For a measurement point to be described by measure data and status information should map the 

devices that can upload both measure data and status information. Two channels are needed: one is analog 

channel for getting measure data; and another is digital channel for getting status information. 
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Mapping…button 

Select a measurement point from the list and Mapping button is activated. Click this button to launch Map 

Channel Window. 

 
Select Device: Display all DAQ devices that are mapped with the selected machine train. 

Select Channel: Display all analog channels under the selected DAQ device. 

Channel X: Display the name of device and channel that is mapped with channel X of the current 

measurement point. If no channel is mapped, it will show “Ineffective”. 

Channel Y: Display the name of device and channel that is mapped with channel Y of the current 

measurement point. If no channel is mapped, it will show “Ineffective”. 

<<: left shift button. 

>>: right shift button. 

 

Example for Channel Mapping:  

Mapping Demands: Train Demo-DTM20_101-Velocity-Channel X maps DTM20_101-Channel 0 and 

Channel 1. Moreover, Channel 0 is an analog channel and Channel 1 is a digital channel. 

Step1: Select DTM20_201[Device0] from list. Channel 0 is displayed in the channel list. 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

56 
 
 
 

 

 

 
Step2: Click “Channel 0” and “Channel X: Ineffective” at the same time, and then click <<. Now 

“Channel X: Ineffective” changes to “Channel X: DTM20_101: Channel 0”. 

 
Step3: Double click “Channel X: DTM20_101: Channel 0”. Mapping Digital Channel window is 

launched. 

 
Step4: Check option of “Enable Mapping Digital Channel” in the window. Select 

DTM20_101[Device0] and click Channel 1. Finally, click OK button. 
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4-20mA Module Setup 

4-20 mA Module Setup Window is used to configure 4-20mA output modules. 

 
Mapping Status Description: 

Mapped: The 4-20mA device channel has mapped the analog channel of DAQ device. 

Un-mapped: The 4-20mA device channel hasn’t mapped the analog channel of DAQ device. 

Question: The 4-20mA device channel has ever mapped the analog channel of DAQ device, but the 

mapped analog channel does not already exist now. The possible situations are: the mapped analog channel 

is changed to digital channel; the DAQ device that contains the mapped analog channel is deleted. 

 

Map Channel…button 

Select a 4-20mA device and a channel under this device and then click Map Channel…button. 
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You can change name of this 4-20mA device channel by entering the new name in edit box of “Channel 

Name”. 

Selecting a DAQ device, all analog channels under this device is listed. Click this channel and then click 

OK to finish the mapping. 

 

Channel 4-20mA Calibration 

Take PT372 as an example: Numerical data range is 0-2000 and current output range is 4mA-20mA. 

The calibration process for a PT372 device is below: 

Step1: select the device and a mapped channel; 

 
Step2: Enter 0 in “Numerical Data For Start Current” edit box and enter 4000 in “Start Current” edit box. 

Click the related Refresh button. 

Step3: Enter 2000 in “Numerical Data For End Current” edit box and enter 20000 in “End Current” edit 

box. Click the related Refresh button. 

The calibration for a current channel has finished, you can repeat step1~step3 to calibrate other current 

channels. After the calibration, you should click OK button to save the operation. 
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Relay Module Setup 

Relay Module Setup Window is used to configure relay devices. 

 
Relay Device: Display all relays in PCM370 system. 

Channel Name: Display name of the selected relay channel. You can change the channel name by 

entering the name in edit box “Channel Name”. And when you switch to another relay channel, the new 

channel name will be displayed. 

 

Channel Property Description: 

Energized: If the relay device is a Normally Energized Relay (NE), you should mark this option. And if 

the relay device is a Normally De-energized Relay (NDE), you should keep this option un-checked. 

 
Latching: Check this option to set the relay latching. If a relay is set with latching, the relay will hold the 

alarm state (contain danger and alert both) until it is reset. For example, in normal condition, when channel 

expression returns 1 or True, the relay alarms. If the relay is set latching and it alarmed, this relay will keep 

the alarm state even if the current channel expression returns 0 or False. 

Bypass: If you check this option, the alarm state (contain danger and alert both) of this relay is inhibited. 

That means the relay expression will always return 0 or False and this relay will never alarm. 

Alarm Delay: Set delay time for each alarm. 
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Below picture show you the relationship between the relay channel state and channel property: 

 
 

Relay Channel Expression Setting: 

Display and set logical output expression for each relay channel. 

(,), And (&), Or (|), Not (~): Operators 

Alarm Selection (Button): Click this button to select channel alarm level. Select a DAQ device first, and 

select a device channel, and then select the alarm level. Specially, if you select a digital channel and select 

the alarm level that wasn’t defined for this channel, this alarm level factor will always return 0 or False.  
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Delete (button): If you want to delete a sub-expression for the relay expression, you can rest your mouse 

pointer behind the sub-expression and then click Delete button to delete it. 

Channel Update (button): If you finished expression setting on a relay channel, you should click this 

button. There are two functions for this operation. The one is checking the validity of expression. If the 

expression is illegal, you will be informed to change it. For example, the expression 

“Device[0].Channel[0].Alert | Device[0].Channel[0].Danger )” is illegal. In the example, left bracket “(” 

is missing. Another function for this button is to save the expression. If the expression is legal, clicking this 

button will save the expression. 
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Custom Trend Setup 

Custom Trend Setup Window is used to set the custom trend plot type. With this function, you can view 

trend plots of several channels on a window. This function helps you compare data from different 

channels. 

 
Trend Type Name: Display the name of a custom trend type. 

Number of Selected Channels: Display total number of the channels that are contained in a custom trend 

type. 

 

Add…button: 

Click this button to add a new custom trend type.  

NOTE: Maximum 8 custom trend plot types can be added. Each custom trend plot type can contain 

maximum 16 channels. 

 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

64 
 
 
 

 

 

Select Machine Train: Display the machine trains that are displayed on PCM Explorer of the current user. 

Available Channel: If you select a machine train, measurement point channels that have been mapped 

under the machine train are listed. 

<<: Left shift button. 

>>: Right shift button. 

Trend Type Name: In this field, you should enter the name for the new custom trend type. Maximum 

length of the custom trend type name is 31 characters. 

Selected Channel: This field lists the selected channels.  

Channel Name: You can change the name of the selected channel in this field by clicking the channel in 

Selected Channel List. If you select a channel from Available Channel list and click << to move it to 

Selected Channel, the full name of the selected channel will be displayed in this field. Maximum length of 

the channel name is 9 characters. If the channel name length exceeds 9 characters, PCM370 will 

automatically throw off the part that exceeds 9 characters and save the anterior 9 characters as the channel 

name. 

 
Example to add a new trend plot type 

Step1: Select the machine train. 

Step2: Select the channel in the Available Channel list and click << to add this channel to Selected 

Channel list. You can change the name in edit box of “Channel Name”. You should control the length of 

the channel name in 9 characters. 

Step3: Repeat Step1 and Step2 until you add all the channels you want. 

Step4: Enter the name for the new custom trend plot type in edit box of “Trend Plot Type”. 

Step5: Click OK. 

 

Modify…button 

Select the custom trend plot type in Custom Trend Setup window and then click Modify…button.  
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In the window, you can change the name of this custom trend plot type. And you can change the name of 

the channels contained in the current custom trend plot type. Also you can change the channel member in 

the custom trend plot type: adding new channels or deleting some channels. 

NOTES: 

When the mapping relationship between a DAQ device channel and a measurement point channel that 

contains in the custom trend plot type is changed, the custom trend plot type is changed also. In this 

condition, you should re-define this trend plot type. Several reasons will result in the changing of mapping 

relationship: 

 The measurement point that is related to the custom trend plot type is deleted. 

 The analog channel that is related to the custom trend plot type is deleted. 

 The measurement point channel is changed to map other analog channel. 

 

 

Delete…button 

Select the custom trend plot type in Custom Trend Setup window and then click Delete…button. If you are 

sure to delete the selected trend plot type, please click Yes on the below window. 
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Dynamic Data Collection Setup 

Dynamic Data Collection Setup Window is used to set dynamic collection conditions for machine train. 

 
Time Trigger: Check it to set time trigger condition. Please select start time and enter the time interval. 

Alarm Trigger: If you check this option, the machine train will be triggered when there is an alarm in any 

channel under this machine train. For analog channels, when channel measure value exceeds alarm set 

points, the channel is in alarm and the alarm will trigger the machine train. Especially for digital channels, 

the channel should be set Alert or Danger bit or set both Alert bit and Danger bit. And also the channel 

should be set “Trigger”, when the Alert bit or Danger bit returns 1 or True, the machine train will be 

triggered. 

The channels that are set “Enable Dynamic Data Collection” beneath the triggered machine train will 

automatically start dynamic data collection.  



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

67 
 
 
 

 

 

Calibration 

Calibration Window is used to calibrate analog channels of DAQ devices. 

 
Modbus proportional range and full scale range are used in calibration. The sampling value is related to 

Modbus proportional range and the measurement value is related to full scale range. Modbus proportional 

range is configured by the related configuration software. 

 

Take DTM20_101[Device0] as an example: Modbus Proportional Range: 0~2000. Full-Scale (high): 12.5 

mm/s; Full-Scale (low): 0mm/s. The calibration setting should be: 

Sampling Value 1: 0; Measurement Value 1: 0mm/s 

Sampling Value 2: 2000; Measurement Value 2: 12.5mm/s 

The calibration process is below: 

Step1: Select DTM20_101[Device0] and Channel0; 

Step2: Enter 0 in edit box of “Sampling Value 1” and enter 0 in edit box of “Measurement Value 1”. And 

then click related Refresh button. 

Step3: Enter 2000 in edit box of “Sampling Value 2” and enter 12.5 in edit box of “Measurement Value 

2”. And then click related Refresh button. 

Step4: Click OK button. 

The calibration process for channel0 of DTM_101[Device0] has finished. If the device has several analog 

channels, you should repeat step1~step3 to calibrate other analog channels. 
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Help Menu 

 

Help Topic 

Show online help of PCM370-CFG software. You also can open the window by pressing F1 on Keyboard. 

 
 

About PCM370-CFG 

Display Copyright, Company Name, Software Version, and Creator information of PCM370-CFG. 
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PCM370-RUN Software Operation 

Start PCM370-RUN software 

NOTE: 

Exit from PCM370-CFG software before you run PCM370-RUN software. PCM370-CFG software and 

PCM370-RUN can’t run at the same time. 

 

There are two methods to run PCM370-RUN software. 

Method 1: Double-click shortcut icon of “PCM370-RUN” on the desktop; 

Method 2: Select Start, All Programs, PCM370, PCM370-RUN; 

 
PCM370-RUN software and PCM370-CFG software share the same login account. Enter user name and 

password in the related edit boxes. Default User Name is “administrator” and Default Password is 

“password”. 

If PCM370-RUN software is installed on Touch Panel computer, you can click Keyboard button to open 

On-Screen Keyboard Window. You are recommended that do not close this window when PCM370-RUN 

software is running. 

 
 

The main window for PCM370-RUN software is below: 
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Machine Train List and Graphics View 

Machine Train List: 

 
Above picture displays Machine Train List in PCM370-RUN software. Machine-trains which are 

displayed in Tree View of PCM370-CFG software are also displayed in Machine-Train List. 

 

Light Color Indication: 

 Green: Normal Status 

 Yellow: Alert Status 

 Red: Danger Status 

 Flashing: Alarm happened but hasn’t been acknowledged.  

Example: If the light color before a machine train shows “Green” and it keep flashing, that means the 

current status of the machine train is in normal but this machine train has ever alarmed and the alarm hasn’t 

been acknowledged yet. 

 

Graphics View 

Graphics View displays two types of view: the one is view about pictures of machine and machine beneath 

the selected machine train, another one is view about pictures of machine and measurement points that 

belongs to this machine. 

 

Color Indication for picture status bar 

 Green: The related machine or measurement point is in normal status. 

 Yellow: The related machine or measurement point is in alert status. 

 Red: The related machine or measurement point is in danger status. 

 Flashing: The alarm happened on the selected machine or measurement point, but it hasn’t been 

acknowledged. 
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Selecting a machine train from Machine Train List, you will see view about machines under this machine 

train. See below: 

 
Double clicking a machine picture in above picture, view about the machine and the related measurement 

points is shown. See below: The machine picture is located on the center of Graphics View as a certain 

size. 

 
If you want to back to the Graphics View about machines, you should click Return on main window. 
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Bar Graph 

Bar graph displays the real time measure value of the channel. In PCM370-RUN software, each bar graph 

window can display maximum 24 bar graphs. If the channel number exceeds 24, you should go to other 

pages to view additional bar graphs. 

 
Bar graph channels selection: 

 View bar graphs of all channels under a machine train: Select the machine train in Machine Train 

List and click Bar Graph button on main window. 

 View bar graphs of channels under a machine: Select the machine train in Machine Train List and 

click the picture of this machine train and then click Bar Graph button on main window. 

 View bar graphs of channels under a measurement point: Select the machine train in Machine 

Train List and double click picture of the machine this measurement point belongs to, and then click 

picture of this measurement point, finally click Bar Graph button on main window. 

 

Bar graph colors indication: 

 Green: Normal Status; 

 Yellow: Alert Status; 

 Red: Danger Status; 

 Blue: No measure value or background color 

 Flashing: The channel has ever alarmed but the alarm event hasn’t been acknowledged. When the 

bar graph color of a channel keeps flashing, you should click Acknowledge Confirm button on the 

window to acknowledge the alarm. 

 

Channel Status Displaying: 
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Only the channel that has mapped device digital channel can display channel status. Left click bar graph of 

the channel, status information tab pops up. See below: 

 
Do not forget the definition for each status bit. When the value that is returned from the status bit changes, 

the light color before this status bit changes too. In PCM370, when the status bit returns 0 or False, the 

color display green, and when the status bit returns 1, the color display red. For example, you has defined 

status bit “OK”. MeaningForFalse is described as “OK” and MeaningForTrue is described as “NOT OK”. 

So if the light color shows red, that means the status of “OK” bit is “NOT OK”. 

 

Plots Displaying 

On the bar graph page window, double-click a bar graph, Diagram Selection window pops up: 

 
 View real time trend plot of the selected channel: Check “Real Time Trend Plot” and then click 

OK. 

 View history trend plot of the selected channel: Check “History Trend Plot” and then click OK. 

 View alarm list of the selected channel: Check “Alarm List” and then click OK. 

 View status list of the selected channel: Check “Status List” and then click OK. 
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Acknowledge Alarm button: 

Click this button on the bar graph page window to acknowledge the alarm status of the machine train 

which the alarmed channel belongs to. 

 

Print…button: 

If you want to print the current bar graph window, you can click this button. 

 
 

Return…button: 

Click this button on the bar graph window to back to the main window. 

 

CAUTION: 

The channel’s measure value which is shown on bar graph is calculated by PCM370-RUN software. The 

color indication of bar graph for each channel depends on two factors: the measure value calculated by 

PCM370-RUN software and the measure value uploaded from DAQ device. Mostly, the measure value 

calculated by PCM370-RUN software is the same as the measure value uploaded from DAQ device. When 

the measure value calculated by PCM370-RUN software isn’t the same as the measure value uploaded 

from DAQ device, it may cause the color indication is not consistent with the measure value shown on bar 

graph. 
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Trend Plot 

PCM370-RUN software display two types of trend plots: real time trend plot and history trend plot. 

Moreover, PCM370-RUN supports displaying trend plot of a measurement point channel, a custom trend 

plot type, and a node in Tree View for real time and history trend plot. Following figure shows you the 

detailed classification of the trend plot. 

 
 

 Real time trend plot of a measurement point channel 

On bar graph page window, double click bar graph of a channel to launch Diagram Selection window. 

Check option of “Real Time Trend Plot” and then click OK button. 

 
Following picture shows you a real time trend plot of a selected measurement point channel. 
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NOTES: 

1. The title of the trend plot: it shows the measurement point name plus channel name. 

2. It shows the real time measure value of the selected channel and color indication for the real time 

measure value. 

3. It shows the color indication for measure value of each status bit. 

4. It shows the trend plot for each status bit. When the bit returns 0, the bit is in normal; and when the bit 

returns 1, the bit is in abnormal. 

5. Red line on the upside shows danger set point; yellow line shows alert set point; blue line shows 

measure value of this channel. 

6. Acknowledge Confirm: Click it to acknowledge the alarm. 

7. Pre: Click it to view real time trend plot of the previous channel on bar graph window. If the current 

channel is the first channel, this button will be disabled. 

8. Next: Click it to view real time trend plot of the next channel on bar graph window. If the current 

channel is the last channel, this button will be disabled. 

9. Print: Click it to print the current trend plot window. 

10. Return: Click it to back to the bar graph window. 

 

 Real time trend plot of a custom trend plot type 
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Directly click Trend Plot on the main window, and a menu pops up. The custom trend plot types that have 

been defined by PCM370-CFG software are listed on the menu. For example, we have defined a custom 

trend plot type named “DTM”, and you should select “DTM(R)” from the menu to view real time trend 

plot of custom trend type “DTM”. 

 
Following picture shows you the real time trend plot of custom trend type “DTM”: 

 
 

 Real-time trend plot of a node in Tree View 

Firstly, select the node. If the node is a machine train, you should select the machine train in Machine Train 

List. If the node is a machine, you should select the machine train in Machine Train List and then click 

picture of this machine in Graphics View. If the node is a measurement point, you should select the 

machine train in Machine Train List, and then in Graphics View double click picture of the machine which 

the selected measurement point belongs to, and finally click picture of the measurement point. 

Secondly, click Trend Plot on the main window and a menu pops up. 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

79 
 
 
 

 

 

For example, you select Train Demo on Machine Train List and click Trend Plot on main window. 

Below is the pop-up menu: you should select Train Demo(R). 

 
Following picture shows you the real time trend plot of the Train Demo. 

 
A trend plot page window can display maximum 16 channels’ trend plots. If the channel number under the 

selected node exceeds 16, you should go to other page to view the additional trend plots. 

 

 History trend plot of a measurement point channel 

On bar graph page window, double click bar graph of the channel to launch Diagram Selection window. 

Check option of “History Trend Plot” and then click OK button. 
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Following picture shows you a history trend plot of a single channel. 

 
NOTES: 

1. The title of the trend plot: it shows the measurement point name plus channel name. 

2. It shows the measure value of the last sample and color indication for the channel’s measure value. 

3. It shows the color indication for measure value of each status bit. 

4. It shows the trend plot for each status bit. When the bit returns 0, the bit is in normal; and when the bit 

returns 1, the bit is in abnormal. 

5. The yellow rectangle shows the measure value and collected time of the selected sample. 

6. It shows time slider, date picker, time picker and Refresh button. You can use the time slider to 

change the time range of trend plot. Also you can use date picker and time picker to change the time 
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range of trend plot. After you change the date and time, you should click “Refresh” button to refresh 

the data and time on the current trend plot window. 

7. Magnify: it is used to zoom in the trend plot. Click this button and drag a rectangle, the plot in this 

rectangle will be magnified. 

8. Restore: click it to restore the magnified plot to original size. 

9. Pre: Click it to view history trend plot of the previous channel on bar graph window. If the current 

channel is the first channel, this button will be disabled. 

10. Next: Click it to view history trend plot of the next channel on bar graph window. If the current 

channel is the last channel, this button will be disabled. 

11. Print: Click it to print the current trend plot window. 

12. Return: Click it to back to the bar graph window. 

 

 History trend plot of a custom trend plot type 

Directly click Trend Plot on the main window, and a menu pops up. The custom trend plot types that have 

been defined by PCM370-CFG software are listed on the menu. For example, we have defined a custom 

trend plot type named “DTM”, and you should select “DTM(H)” from the menu to view history trend plot 

of custom trend type “DTM”. 

 
Following picture shows you the history trend plot of the custom trend type “DTM”: 
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 History trend plot of a node in Tree View 

Firstly, select the node. If the node is a machine train, you should select the machine train in Machine Train 

List. If the node is a machine, you should select the machine train in Machine Train List and then click 

picture of this machine in Graphics View. If the node is a measurement point, you should select the 

machine train in Machine Train List, and then in Graphics View double click picture of the machine which 

the selected measurement point belongs to, and finally click picture of the measurement point. 

Secondly, click Trend Plot on the main window and a menu pops up. 

For example, you select Train Demo on Machine Train List and click Trend Plot on main window. 

Below is the pop-up menu: you should select Train Demo (H). 

 
Following picture shows you the history trend plot of the Train Demo. 
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A trend plot page window can display maximum 16 channels’ trend plots. If the channel number under the 

selected node exceeds 16, you should go to other page to view the additional trend plots. 
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Alarm List 

PCM370-RUN software display two types of alarm list: alarm list for a measurement point channel and 

alarm list for a node.  

 Alarm list of a measurement point channel 

On bar graph page window, double click bar graph of the channel to launch Diagram Selection window. 

Check option of “Alarm List” and then click OK button. 

 
In Time range window below, you should select the time range and then click OK button. If you want to 

view all alarm events under the selected measurement point channel, you should check “Total alarm list” 

and then click OK button. If you want to view alarm events in certain time range, you should check 

“Partial alarm list”, and set the start time and ending time, and finally click OK button.  

 
Following picture shows you the alarm list in the selected time range of the current measurement point 

channel. 
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Each alarm list page can contain maximum 50 alarm events. 

 

 Alarm list of a node 

Firstly, select the node. If the node is a machine train, you should select the machine train in Machine Train 

List. If the node is a machine, you should select the machine train in Machine Train List and then click 

picture of this machine in Graphics View. If the node is a measurement point, you should select the 

machine train in Machine Train List, and then in Graphics View double click picture of the machine which 

the selected measurement point belongs to, and finally click picture of the measurement point. 

Secondly, click Alarm List on the main window. 

For example, you select Train Demo on Machine Train List and click Alarm List on main window. The 

time range window is launched.  

 
Select the time range and then click OK button. If you want to view all alarm events under the selected 

node, you should check “Total alarm list” and then click OK button. If you want to view alarm events in 
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certain time range, you should check “Partial alarm list”, and set the start time and ending time, and finally 

click OK button. 

Following picture shows you the alarm list in the selected time range of Train Demo. 

 
Each alarm list page can contain maximum 50 alarm events. 
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Status List 

PCM370-RUN software display two types of status list: status list for a measurement point channel and 

status list for a node. 

NOTE: 

Status list shows the measure value and status information of each measurement point channel. In Name 

column of status list window, the channel name plus (A) indicates the analog channel and the channel 

name plus (D) indicates the digital channel. If a measurement point channel maps both analog channel and 

digital channel, in Digital Status column of status list window, the value for each status bit will be shown 

by the order you have defined on PCM370-CFG software. 

 

 Status list of a single channel 

On bar graph page window, double click bar graph of the channel to launch Diagram Selection window. 

Check option of Status List and then click OK button. 

 
Following picture shows you status list window of the selected measurement point channel. 
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 Status list of a node 

Firstly, select the node. If the node is a machine train, you should select the machine train in Machine Train 

List. If the node is a machine, you should select the machine train in Machine Train List and then click 

picture of this machine in Graphics View. If the node is a measurement point, you should select the 

machine train in Machine Train List, and then in Graphics View double click picture of the machine which 

the selected measurement point belongs to, and finally click picture of the measurement point. 

Secondly, click Status List on the main window. 

For example, you select Train Demo on Machine Train List and click Status List on main window.  

Following picture shows you status list window of Train Demo. 
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Reset Relay 

Click Reset Relay on the main window to reset all relays in PCM370 system. 

 

Acknowledge Alarm 

Click Acknowledge Alarm on the window to acknowledge the alarm in the related machine train. 

There are three Acknowledge Alarm buttons in PCM370-RUN software. They are respectively designed 

on main window, bar graph window, and real time trend plot window. Three buttons work the same. 

If the machine train is set the “Alarm Trigger” function by PCM370-CFG software, when the first alarm 

happens on this machine train, DAQ channels which are mapped with the machine train and which are set 

“Enable Dynamic Data Collection” function will automatically start dynamic data collection. If you didn’t 

acknowledge the alarm this time, when the alarm happens next time, the DAQ channels won’t start 

dynamic data collection. 

The un-acknowledged alarm will cause the color flashing on the picture of related machine train, machine 

and measurement point. 

 

Help 

Show online help of PCM370-RUN software. 
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 PT371 Input Module 

Features 

 16 channels input module 

 

Specifications 

Communication Parameters: 

 Protocol: Modbus RTU 

 Serial Interface: RS485 

 Data Bit: 8 bits 

 Stop Bit: 1 bit 

 Parity Bit: None 

 Available Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400bps 

 Available Slave Address: 1~32 
 

Signal Input: 

 Voltage input: 0~10 V; -5V~+5V 

 Current input: 4~20mA (with the shut resistor) 

 Thermocouple or thermo resistor 

 Discrete input: any 0~20V; 0~12V; 0~5V 

 TC: K, E, S, T, N, J, B, R, EU-2 

 Compensation mode: Inner, Specify and Exterior 

 RTD: Pt100, Cu50, Cu100, BA1, BA2, G 

 Wire Unit: 2-wires, 3-wires 

 

Data acquisition rate: 

1.0sec 

 

Amplitude resolution: 

 PT371 module: 12 bit 0.2%FS 

 

Power supply: 

24VDC +/- 10% @150 mA  

 

Environmental 
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 Temperature: 0~45℃ 

 Humidity: ＜85%RH 

 

Physical 

 Dimension: 141mm×87mm×69mm 

 Weight: 0.6Kg 

PT371

predictech

01 02 03 04 05  06 07 08 09 10 11 12 13 14 15  16 17 18 19 20

21 22 23 24 25 26 27 28  29 30 31 32 33 34  35 36 37 N   L

 
 

Accessories 

 TM900 (Power converter) 
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PT372 Current Output Module 

Features 

 4 channel 4~20mA output module used with PCM370 system. 

 

Specifications 

Communication Parameters: 

 Protocol: Modbus RTU 

 Serial Interface: RS485 

 Data Bit: 8 bits 

 Stop Bit: 1 bit 

 Parity Bit: None 

 Available Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400bps 

 Available Slave Address: 1~32 

 

Amplitude resolution: 

 PT372 module: 12 bit 

 

Power supply: 

 24VDC +/- 10% @100 mA 

 

Maximum load: 

750 ohms 

 

Environmental 

 Temperature:0~45℃ 

 Humidity: ＜85%RH 

 

Physical 

 Dimension: 141mm×87mm×69mm 

 Weight: 0.6 Kg 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

93 
 
 
 

 

 

PT372

predictech

01 02 03 04 05  06 07 08 09 10 11 12 13 14 15  16 17 18 19 20

21 22 23 24 25 26 27 28  29 30 31 32 33 34  35 36 37 N   L

 
 

Accessories 

 TM900 (Power converter) 



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

94 
 
 
 

 

 

PT373 Relay Module 

Features 

 A 16 channel relay module designed for the PCM370 system output (for alarm outputs). 

 PT373 can be configured for any logic combination of alarms or status of each channel from PCM370 

system. 

 The relays are selectable as: energized/de-energized, latching/non-latching and bypass. 

 

Specifications 

Communication Parameters: 

 Protocol: Modbus RTU 

 Serial Interface: RS485 

 Data Bit: 8 bits 

 Stop Bit: 1 bit 

 Parity Bit: None 

 Available Baud Rate: 1200, 2400, 4800, 9600, 19200, 38400bps 

 Available Slave Address: 1~32 

 

Power supply: 

 24VDC +/- 10% @150 mA  

 

Relays: 

 Seal: epoxy 

 Capacity: 0.5A/230VAC/30VDC, resistive load 

 Relay type: SPTD 

 Isolation: 1000VDC 

 

Environmental 

 Temperature: 0~45℃ 

 Humidity: ＜85%RH 

 

Physical 

 Dimension: 141mm×87mm×69mm 

 Weight: 0.6 Kg 
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PT373

predictech

01 02 03 04 05  06 07 08 09 10 11 12 13 14 15  16 17 18 19 20

21 22 23 24 25 26 27 28  29 30 31 32 33 34  35 36 37 N   L

 
 

Accessories 

 TM900 (Power converter) 
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PCM370 Maintenance 

System Accessories 

PT371 Input module 

16 channels multiple input modules (voltage input, current input, RTD, digital input/relay) 

PT372 4-20mA output module 

4 channels with a 4-20mA output module 

PT373 relay module 

16 channels relay module 

DTM96 

RS485 to RS232/RS485/RS422 converter with signal isolation for Modbus connection 

RS232-RS232 

RS232 to USB converter for Modbus connection 

RS485- USB 

RS485 to USB converter for Modbus connection with isolation 

PCM-TOUCH 

Touch panel computer that works with PCM370 software 

PCM-DPC 

Desktop computer that works with PCM370 software 

 

Troubleshooting 

No communication between Devices and Computer 

 Cables between devices and devices are well connected 

 Cables between devices and computer are well connected 

 computer COM is work well 

 COM parameters are correctly set. 
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AppendixⅠ Ends contents for PT371 

Table1. Ends contents for PT371 

End No. 
Function 

Description 
End No. 

Function 

Description 
End No. 

Function 

Description 

1 
Channel 1 Input 

(a) 
15 

Channel 8 Input 

(a) 
29 

Channel 15 Input 

(a) 

2 
Channel 1 Input 

(b) 
16 

Channel 8 Input 

(b) 
30 

Channel 15 Input 

(b) 

3 
Channel 2 Input 

(a) 
17 

Channel 9 Input 

(a) 
31 

Channel 16 Input 

(a) 

4 
Channel 2 Input 

(b) 
18 

Channel 9 Input 

(b) 
32 

Channel 16 Input 

(b) 

5 
Channel 3 Input 

(a) 
19 

Channel 10 Input 

(a) 
33 

Signal 

Public-Ends c 

6 
Channel 3 Input 

(b) 
20 

Channel 10 Input 

(b) 
34 Parameter Setup 

7 
Channel 4 Input 

(a) 
21 

Channel 11 Input 

(a) 
35 

RS485 grounding

(Digital signal 

grounding) 

8 
Channel 4 Input 

(b) 
22 

Channel 11 Input 

(b) 
36 RS485 (B) 

9 
Channel 5 Input 

(a) 
23 

Channel 12 Input 

(a) 
37 RS485 (A) 

10 
Channel 5 Input 

(b) 
24 

Channel 12 Input 

(b) 

 
 

11 
Channel 6 Input 

(a) 
25 

Channel 13 Input 

(a) 
N 24V- 

12 
Channel 6 Input 

(b) 
26 

Channel 13 Input 

(b) 
L 24V+ 

13 
Channel 7 Input 

(a) 
27 

Channel 14 Input 

(a) 
  

14 
Channel 7 Input 

(b) 
28 

Channel14 Input 

(b) 
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AppendixⅡ Ends contents for PT372 

Table2.Ends contents for PT372 

End No. 
Function 

Description 
End No. 

Function 

Description 
End No. 

Function 

Description 

1 Relay 1Output (A) 15 
Relay 8 Output 

(A) 
29  

2 
Relay 1 Output 

(B) 
16 

Relay 8 Output 

(B) 
30  

3 
Relay 2 Output 

(A) 
17  31  

4 
Relay 2 Output 

(B) 
18  32  

5 
Relay 3 Output 

(A) 
19  33 

Digital-Signal 

Grounding 

6 
Relay 3 Output 

(B) 
20  34 Parameter Setup 

7 
Relay 4 Output 

(A) 
21 

Group 1 Analog 

Signal Output (a)
35 

RS485 Grounding

(Digital-Signal 

Grounding) 

8 
Relay 4 Output 

(B) 
22 

Group 1 analog 

signal output (b) 
36 RS485 (B) 

9 
Relay 5 Output 

(A) 
23 

Group 2 analog 

signal output (a) 
37 RS485 (A) 

10 
Relay 5 Output 

(B) 
24 

Group 2 analog 

signal output (b) 

 
 

11 
Relay 6 Output 

(A) 
25 

Group 3 analog 

signal output (a) 
N 24V- 

12 
Relay 6 Output 

(B) 
26 

Group 3 analog 

signal output (b) 
L 24V+ 

13 
Relay 7 Output 

(A) 
27 

Group 4 analog 

signal output (a) 
  

14 
Relay 7 Output 

(B) 
28 

Group 4 analog 

signal output (b) 
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AppendixⅢ Ends contents for PT373 

Table3.Ends contents for PT373 

End No. 
Function 

Description 
End No. 

Function 

Description 
End No. 

Function 

Description 

1 
Relay 1 Output 

(A) 
15 

Relay 8 Output 

(A) 
29 

Relay 15 Output 

(A) 

2 
Relay 1 Output 

(B) 
16 

Relay 8 Output 

(B) 
30 

Relay 15 Output 

(B) 

3 
Relay 2 Output 

(A) 
17 

Relay 9 Output 

(A) 
31 

Relay 16  Output 

(A) 

4 
Relay 2 Output 

(B) 
18 

Relay 9 Output 

(B) 
32 

Relay 16 Output 

(B) 

5 
Relay 3 Output 

(A) 
19 

Relay 10 Output 

(A) 
33 

(Digital-Signal 

Grounding) 

6 
Relay 3 Output 

(B) 
20 

Relay 10 Output 

(B) 
34 Parameter Setup 

7 
Relay 4 Output 

(A) 
21 

Relay 11 Output 

(A) 
35 

RS485 Grounding

(Digital-Signal 

Grounding) 

8 
Relay 4 Output 

(B) 
22 

Relay 11 Output 

(B) 
36 RS485 (B) 

9 
Relay 5 Output 

(A) 
23 

Relay 12 Output 

(A) 
37 RS485 (A) 

10 
Relay 5 Output 

(B) 
24 

Relay 12 Output 

(B) 

 
 

11 
Relay 6 Output 

(A) 
25 

Relay 13 Output 

(A) 
N 24V- 

12 
Relay 6 Output 

(B) 
26 

Relay 13 Output 

(B) 
L 24V+ 

13 
Relay 7 Output 

(A) 
27 

Relay 14 Output 

(A) 
  

14 
Relay 7 Output 

(B) 
28 

Relay 14 Output 

(B) 
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AppendixⅣ Register Address for PT37X devices 

Table4. Channel No. and Register Address for PT37X devices 

Device 
Channel 

Property 

Channel 

No. 

Register 

Address for 

Analog 

Channel 

Device
Channel 

Property 

Channel 

No. 

Register 

Address for 

Analog 

Channel 

Channel 0 30001 Channel 0 1 

Channel 1 30002 Channel 1 2 

Channel 2 30003 Channel 2 3 

Channel 3 30004 Channel 3 4 

Channel 4 30005 Channel 4 5 

Channel 5 30006 Channel 5 6 

Channel 6 30007 Channel 6 7 

Channel 7 30008 Channel 7 8 

Channel 8 30009 Channel 8 9 

Channel 9 30010 Channel 9 10 

Channel 10 30011 Channel 10 11 

Channel 11 30012 Channel 11 12 

Channel 12 30013 Channel 12 13 

Channel 13 30014 Channel 13 14 

Channel 14 30015 Channel 14 15 

 PT371 Input 

Channel 15 30016 

PT373
Relay 

Output 

Channel 15 16 

Channel 0 40001 Channel 2 3 

Channel 1 40002 Channel 3 4 

Channel 2 40003 Channel 4 5 

4-20mA 

Output 

Channel 3 40004 Channel 5 6 

Channel 0 1 Channel 6 7 

PT372 

Relay 

Output Channel 1 2 

PT372
Relay 

Output 

Channel 7 8 
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AppendixⅤ Register Address for other Modbus based Devices 

Table5. Register Address for other Modbus based Devices 

Device Channel Property Register Address for 
Analog Channel 

Register Address for 
Digital Channel 

DTM Input 30501 10139 

PT580 Input 30501 10139 

30501 10139 
DM200 Input 

30503 10147 
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AppendixⅥ Glossary 

This glossary is a partial list of terms and definitions used in the field of rotating machinery measurement, monitoring, and 

analysis.  These definitions are not universal, but are expressed in the context of this specialized field.   In some instances, 

ProvibTech Corporation has redefined terms from other technical fields for its own purposes. 

Many definitions cross reference terms that may be found elsewhere in the Glossary.  If a term is highlighted, click on it 

once (use the left mouse button) to view its definition in a popup box; click again to return. 

Alphabetical Index Abbreviations 

 

* Absolute Vibration  

Vibration of an object as measured relative to an inertial (fixed) reference frame. Accelerometers and velocity transducers 

measure absolute vibration typically of machine housings or structures; thus they are referred to as seismic transducers or 

inertial transducers. 

* Acceleration  

The time rate of change of velocity.  For harmonic motion, this is often expressed as g or a.  Typical units for acceleration 

are feet per second per second (ft/s2), meters per second per second (m/s2), or more commonly "g" (where g = 

acceleration of earth's gravity = 386.1 in/s2 = 32.17 ft/s2 = 9.81 m/s2).  Acceleration measurements are generally made 

with piezoelectric accelerometers and are typically used to evaluate high frequency machine casing or bearing housing 

response characteristics. 

* Accelerometer  

An accelerometer is an inertial transducer which converts the acceleration characteristic of vibration into a proportional 

electric signal. 

* Acceptance Region  

Trend information of the 1X or 2X vibration vectors (amplitude and phase lag angle) presented in polar format, or the 

shaft average centerline position in Cartesian format.  The user defines the normal Acceptance Region for each shaft 

radial vibration or position measurement on the machine, based on historical data for the machine under all normal 

operating conditions.   

Some systems provide hardware and/or software alarm (Alert and Danger) set point capability.  Alarm set points are set 

independently for maximum and minimum values of both amplitude and phase.  Acceptance Region information is the 

most important indicator of a shaft crack. 

* Aero-derivative  

Aircraft jet engines that have been adapted and modified for industrial use. 

* Aliasing  

False frequency components caused by sampling a dynamic signal at too low a sampling frequency.  The sampling 

frequency must be at least twice the highest frequency of interest or the highest frequency component in the signal.  This 

effect can be eliminated by adjusting the sampling frequency, or using a low-pass filter on the signal prior to sampling 
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(anti-aliasing.)  The primary disadvantage of anti-aliasing (as is the case with virtually any type of filtering) is that phase 

and amplitude errors are incurred. 

* Alignment  

The positioning of machine components; bearings, rotors, casing, foundation, piping, etc., with respect to each other for 

efficient transfer of power.  Various alignment requirements utilize different techniques of cold and hot machine 

measurement including optical, mechanical (dial indicators), electronic (proximity probes), and laser. 

* Amplification Factor, Non-synchronous  

A measure of the susceptibility of a rotor system vibration response to a non-synchronous harmonic exciting force at a 

rotor system natural frequency.   Synchronous amplification factor differs from non-synchronous amplification factor due 

to the existence of destabilizing tangential forces which depend on shaft rotative speed.   At high rotative speeds these 

destabilizing factors cause a decrease in system quadrature dynamic stiffness and result in a non-synchronous 

amplification factor higher than the synchronous amplification factor. 

* Amplification Factor, Synchronous  

A measure of the susceptibility of a rotor system vibration response to an imbalance-related exciting force when shaft 

rotative speed is equal to a rotor system natural frequency.  A calculation technique is similar to measuring the Q of a filter 

(the center frequency divided by the bandwidth), i.e., the balance resonance speed divided by the difference between the 

speeds at the -3dB amplitude values.   Caution should be used when applying this latter method because of the potential 

mechanical abnormalities of machinery vibration response.    

In general, a high synchronous amplification factor indicates low system quadrature dynamic stiffness, whereas a low 

amplification factor generally indicates high system quadrature dynamic stiffness.  

Due to several factors, amplification factor measured during machine startup is different from that measured during coast 

down. Also called machine Q, synchronous amplification factor differs from non-synchronous amplification factor by an 

amount related to the existence of a tangential force which depends on actual shaft rotative speed. See Dynamic Stiffness, 

Quadrature. 

* Amplitude  

The magnitude of periodic dynamic motion (vibration). Amplitude is typically expressed in terms of signal level, e.g., 

millivolts or milliamps, or the engineering units of the measured variable, e.g., mils, micrometres (for displacement), 

inches per second (for velocity), etc. The amplitude of a signal can be measured in terms of peak-to-peak, zero-to-peak, 

root mean square, or average. 

* Amplitude and Phase Versus Time (APHT)  

An acronym used to describe the trend plot of plot vibration amplitude and phase data. This data may be presented in both 

Cartesian and polar formats.  Commonly used for 1X, 2X and nX vibration data. 

* Anti-aliasing Filter  

A low-pass filter which is used to eliminate false frequency components from the spectrum of a digitally sampled signal. 

See Aliasing. 

* Anti-Swirl  
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A technique used in fluid handling machines to decrease or prevent the development of fluid circumferential flow around 

the rotor in bearings and seals, and to improve rotor stability. 

* Asynchronous or Non-synchronous  

Vibration frequency component which is different than shaft rotative speed.  Sometimes used to mean any vibration 

frequency which is not an integer multiple or fraction of rotative frequency.  See Synchronous. 

* Attitude Angle  

The included angle between the direction of the vector sum of all the unidirectional, steady state, radial loads (Preloads) 

on a rotor and a line connecting the bearing and shaft centers.  Sometimes confused with Rotor Position Angle, since the 

preload historically and incorrectly, was considered to be primarily gravity on horizontal machines.  See Rotor Position 

Angle and Eccentricity Ratio, Average. 

* Average  

An amplitude detection technique used for sine wave vibration signals; the half cycle average is 0.637 x zero-to-peak 

amplitude.  Average amplitude detection is not used by ProvibTech because machinery vibration signals are most often 

non-sinusoidal in form and the peak-to-peak, or peak amplitude, cannot be correctly computed. 

* Average Shaft Position  

The static or average position of the shaft relative to a stationary component on the machine to which the probe is 

mounted.  The most common application is rotor axial thrust position relative to the thrust bearing.  Another important 

application is shaft average radial position in the bearing.  These measurements are made using the dc (position) 

component of the proximity probe signal.  Two proximity probes mounted in an XY configuration are required for the 

two-dimensional radial position measurement. 

* Axial  

In the same direction as the shaft centerline. 

* Axial Position  

The average position, or change in position, of a rotor in the axial direction with respect to some fixed reference.  

Typically, the reference is the thrust bearing support structure or other casing member to which the probe is mounted.  The 

probe may observe the thrust collar directly or some other integral, axial shaft surface, as long as it is within about 12 

inches of the thrust bearing.  Also called thrust position.  See Differential Expansion. 

* Balance-of-Plant Machinery  

That group of rotating machinery which is not critical to any part of the overall plant process. Many of these machines 

operate in tandem or spared installations. 

* Balance Resonance Speed  

A shaft rotative speed (or speed region) which equals a natural frequency of the rotor system.  When a rotor accelerates or 

decelerates through this speed region, the observed vibration characteristics are (1) a peak in the 1X Amplitude and (2) a 

more rapid change in the 1X vibration phase lag angle. 

* Balancing  
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Adjusting the radical mass distribution of a rotor so that the mass centerline (principal inertia axis) approaches or 

coincides with the rotor rotational axis.  This reduces the 1X lateral vibration of the rotor and the forces on the bearings 

due to imbalance inertia forces. 

* Band-Pass Filter  

A filter that has a single transmission band extending from a non-zero lower corner frequency to a finite upper corner 

frequency.  The corner frequencies are the frequencies on either side of the center frequency where the amplitude is 

attenuated by 3dB.  At the center frequency, the signal amplitude is not attenuated. 

* Bandwidth  

The span between the corner frequencies of a band-pass filter.  Normally expressed in terms of frequency for constant 

bandwidth filters and as a percent of the center frequency for constant percentage (constant Q) filters.  See Band-Pass 

Filter. 

* Blade Passing Frequency  

A potential vibration frequency on any bladed machine (turbine, axial compressor, fan, propeller, etc.). It equals the 

number of blades (on a disk or stage) times shaft rotative speed. 

* Bode Plot  

A pair of graphs in Cartesian format displaying the 1X vibration vector (phase and amplitude) response as a function of 

shaft rotative speed.  The Y axis of the top graph represents 1X phase lag angle, while the Y axis of the bottom graph 

represents 1X amplitude.  The common X axis represents shaft rotative speed.  Sometimes called an imbalance response 

plot.  Also used for 2X, 3X, ETC. .Vibration response vectors. 

* Bow  

A shaft condition such that the geometric shaft centerline is not straight.  Usually the centerline is bent in a single plane 

due to gravity sag, thermal warpage, etc.; however, the bow may be three dimensional (corkscrew).  Shaft bow can be 

detected by measuring the shaft relative displacement with a proximity probe(s) at rotor slow roll speed.  See Eccentricity 

Peak-to-Peak. 

* Calibration Weight  

Used in rotor balancing procedures, a weight of known magnitude which is placed on the rotor at a known location, under 

known operating conditions, in order to measure the resulting change in machine 1X vibration response.   In effect, such a 

procedure "calibrates" the rotor system (a known input is applied, and the resultant output is measured) for its 

susceptibility to imbalance.  Sometimes called "trial weight" 

* Campbell Diagram  

A diagram used in rotating machinery design.   A tool for selecting and checking shaft operational rotative speeds and 

other possible forcing function frequencies against the spectrum of natural frequencies to avoid resonances.  The X axis 

represents the various possible excitation frequencies, i.e., rotative speed (1X), oil whirl (.40-.48X), blade or vane passing 

frequencies, gear mesh frequencies, etc.   The Y axis represents the lateral and torsional natural frequencies.  The term is 

sometimes used incorrectly to describe the Cascade Plot and Waterfall Plot.  See torsional vibration 

* Cartesian Format  
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A rectangular graphical format consisting of a vertical (Y) axis and a horizontal (X) axis.  This format is used to graph the 

results of one variable as a function of another; e.g., vibration amplitude versus time (trend), amplitude versus frequency 

(spectrum) and nX amplitude versus shaft rotative speed (Bode). 

* Cascade Plot  

A graph in Cartesian format displaying amplitude versus frequency spectra at series shaft rotative speeds.  Shaft rotative 

speed and amplitude are usually presented on two separate vertical axes.  Frequency is measured on the horizontal (X) 

axis.  This data format is used to evaluate the change in vibration frequency characteristics during machine transient 

conditions.  See Waterfall Plot. 

* Casing Expansion  

A measurement of the axial position of the machine casing relative to a fixed reference, usually the foundation.  The 

measurement is typically made with an LVDT installed on the foundation at the opposite end of the machine from the 

point where the casing is attached to the foundation.  Changes in casing axial position are the result of thermal expansion 

and contraction of the casing during startup and shutdown.  The measurement is usually incorporated as part of a TSI 

system. 

* Center Frequency  

For band-pass filters the arithmetic center of a constant bandwidth filter or the geometric center (midpoint on a 

logarithmic scale) of a constant percentage filter. 

* Channel  

A transducer and the instrumentation hardware to display its output signal. 

* Cold Water Stands  

An arrangement of piping and brackets installed along a machine foundation for hot alignment measurements.  Proximity 

probes observe exposed shaft areas or targets on the machine casing from brackets through which water circulates.  This 

provides a thermally stable reference for the alignment measurement. 

* Communications Processor  

An interface module used in an on-line monitoring system to communicate data from the monitor rack to the computer.  

ProvibTech Communications Processors include Dynamic Data Manager (steady state static data and steady state 

dynamic data), Transient Data Manager (steady state, transient static data and transient dynamic data), and Process Data 

Manager (process variable data). 

* Constant Bandwidth Filter  

A band-pass filters having a fixed frequency bandwidth regardless of center frequency. 

* Constant Percentage Filter  

A band-pass filters whose bandwidth is a fixed percentage of the center frequency.  Also called constant Q filter. 

* Critical Machinery  

That group of rotating equipment which is absolutely necessary to a major part of the plant process.  When critical 

machinery is not operating, that part of the process is not operating.  Machines in this category are usually un-spared and 

are typically monitored continuously. 

* Critical Speed(s)  



PCM370 Plant Condition Monitoring System 
 
 
 

 
ProvibTech      Phone: +1-713-830-7601 Fax: +1-281-754-4972 sales@provibtech.com , www.provibtech.com        

107 
 
 
 

 

 

In general, any shaft rotative speed which is associated with high (dangerous level) vibration amplitude.  Often, critical 

speed is used to describe a shaft rotative speed equal to a rotor system natural frequency.  This is more correctly called a 

balance resonance speed. 

* Critical Speed Map  

An XY (Cartesian) diagram used in rotating machinery design as a tool to approximate the effect of changes in bearings 

supports, and pedestal designs on system natural frequencies.  The X axis represents bearing stiffness and the Y axis 

represents rotor system natural frequency. 

* Cross Axis Sensitivity  

The ratio of change in the signal output to an incremental change in the input along any axis perpendicular to the sensitive 

axis of an inertial (seismic) transducer. 

* Cross Talk  

Interference or noise in a transducer signal or channel which originates in another transducer or channel.  When using 

proximity probes, cross talk can occur when the tips of two (or more) probes are too close together.  The interaction of the 

probes' electromagnetic fields causes a noise component in each of the transducers' output signals.  The frequency of the 

noise component is the difference (beat frequency) of the two proximate oscillator frequencies. 

* Cycle  

One complete sequence of values of a periodic quantity. 

* Decibels  

A numerical expression of the ratio of the power or voltage levels of electrical signals. dB = 10 log P1/P2 = 20 log V1/V2. 

* Difference Analysis  

A method for evaluating the change in a measurement variable. Two sets of data are collected at different points in time, 

or under different conditions, and are subtracted from each other. 

* Differential Expansion  

The measurement of the axial position of the rotor with respect to the machine casing at some distance from the thrust 

bearing. Changes in axial rotor position relative to the casing affect axial clearances and are usually the result of thermal 

expansion during startup and shutdown.  The measurement is typically made with a proximity probe transducer mounted 

to the machine casing and observing an axial surface (e.g., collar) of the rotor. The measurement is usually incorporated as 

part of a TSI system. 

* Differential Phase  

A technique which measures the phase difference between vibration signals of a chosen single frequency at different 

longitudinal locations on a rotor system.  It is used for location of the source of instability. The vibration signal whose 

phase leads all others usually indicates the transducer location closest to the source of the instability. 

* Direct Data   

Data or a signal, which represents the original transducer signal.  Sometimes called unfiltered, raw, all pass, or overall 

data or signal. 

* Displacement  
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The change in distance or position of an object relative to a reference. Machinery vibration displacement is typically a 

peak-to-peak measurement of the observed vibrational motion, and is usually expressed in units of mils or micrometres.  

Proximity probes measure displacement directly.  Signal integration is required to convert a velocity signal to 

displacement. 

* Dual Path  

A signal conditioning technique used in vibration monitors whereby a single transducer input is processed through two 

separate signal conditioning paths in the monitor.  Each signal conditioning path can have its own engineering units of 

measurement (e.g., displacement and velocity), optional filtering, alarm set points and displays. 

* Dual Probe  

A transducer set consisting of a proximity probe and velocity transducer installed radially at the same point (usually in a 

common junction box on the machine bearing housing).  Four separate measurements are provided by this transducer 

system.  The proximity probe measures (1) shaft relative radial position within the bearing clearance, and (2) shaft 

dynamic motion relative to the bearing.  The velocity transducer measures (3) machine casing absolute vibration.  When 

the velocity signal is integrated to displacement and added to the shaft relative signal, the summation represents (4) shaft 

absolute motion. 

* Dual Voting  

A logical AND relationship between two independent monitor inputs; they must agree before any action is taken.  For 

example, two transducer input signals must both exceed an amplitude set point (usually the Danger set point only) before 

an actual alarm condition is indicated by the monitor.  If only one transducer input exceeds the set point, then no alarm is 

initiated in the monitor. 

* Dynamic Data  

Data (steady state and/or transient) which contain that part of the transducer signal representing the dynamic (e.g., 

vibration) characteristics of the measured variable.  Typical dynamic data presentations include Orbit, Timebase, 

spectrum, Polar, Bode, Cascade, and Waterfall.  From this data it is possible to derive static data such as amplitude, 

frequency filtered amplitude, and phase lag angle from the signal. See Steady State Dynamic Data and Transient Dynamic 

Data. 

* Dynamic Stiffness  

Spring stiffness of the mechanical system complemented by the dynamic effects of mass and damping which act against 

an applied dynamic force to limit vibration response. 

* Dynamic Stiffness, Direct  

The component of mechanical system Dynamic Stiffness, consisting of modal mass, stiffness, and cross couple damping 

terms, which collinearly opposes the applied force. 

* Dynamic Stiffness, Quadrature  

The component of a Dynamic Stiffness mechanical system Dynamic Stiffness in a fluid environment, consisting of 1) the 

viscous damping (the reaction of the fluid when the shaft presses on it); and 2) the fluid wedge support term (the reaction 

of the shaft when the fluid pushes on it).  The latter is cross-coupled stiffness (tangential force component).  Quadrature 

dynamic stiffness acts perpendicularly to the applied force (90 degrees out of phase). 
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* Eccentricity, Mechanical  

The variation of the outer diameter of a shaft surface when referenced to the true geometric centerline of the shaft. 

Out-of-roundness. See Mechanical Runout. 

* Eccentricity Peak-to-Peak  

The measurement of shaft bow at slow roll speed.  The shaft bow may be due to; (1) fixed mechanical bow, (2) temporary 

thermal bow, or (3) temporary bow due to any sort of sag or bow at rest, sometimes called gravity bow. 

* Eccentricity Ratio, Average  

A dimensionless quantity representing the average position of the shaft within the bearing (or seal). The average 

eccentricity ratio, obtained by dividing the distance between the average position of the shaft centerline and the bearing 

(seal) centerline by the radial clearance, can vary between zero and one.  Zero represents the shaft concentric with the 

bearing (seal), and one represents the shaft in contact with the bearing (seal).  A trend of decreasing eccentricity ratio can 

indicate a potential stability problem.  See  Rotor Position Angle and Attitude Angle. 

* Eccentricity Ratio, Dynamic  

A dimensionless quantity representing the instantaneous position of the shaft within the bearing (or seal).  The dynamic 

eccentricity ratio, obtained by dividing the distance between shaft and bearing (seal) centerlines by the radial clearance, 

can vary between zero and one.  Zero represents the shaft concentric with the bearing (seal), and one represents the shaft 

in contact with the bearing (seal). See Eccentricity Ratio, Average. 

* Eddy Current  

Electrical current which is generated in a conductive material when such material intercepts the electromagnetic field of a 

proximity probe. 

* Electrical Runout  

A noise component in the output signal of a proximity probe transducer system resulting from non-uniform electrical 

conductivity and magnetic permeability properties of the observed material.  Also caused by local (spot) magnetic fields 

on the circumference of the shaft surface.  A change in the Proximate output signal which does not result from a probe gap 

change (dynamic motion or change in average shaft position).  The error repeats exactly with each shaft revolution.  See 

Mechanical Runout. 

* Element Passage Frequency  

(EPx) For purposes of studying rolling element bearings, using either bearing housing transducers or the ProvibTech 

REBAM system, EPx is a symbolic indication of the rate at which rolling elements pass a fixed point on either the inner or 

outer race.  Harmonics of the element passage frequency are then indicated as 2EPx, 3EPx, .., nEPx. 

* Error  

The difference between the indicated value and the true value of the measured variable. It is often expressed as relative 

error, i.e., as a percent of the output reading of the transducer. 

* Essential Machinery  

That group of rotating equipment which is critical to part of the plant process.  When essential machinery is not operating, 

the overall plant is not operating to full capacity.  Machines in this category can be spared or un-spared and are typically 

monitored continuously. 
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* Filter  

Electronic circuitry designed to pass or reject a specific frequency band of a signal. 

* Fluid Circumferential Average Velocity Ratio 

A dimensionless ratio of the average rate of rotation of a fluid (in a bearing or seal clearance or in rotor to stator periphery) 

in the direction of shaft rotation divided by shaft rotative speed. Lambda times rotative speed is the angular velocity at 

which the fluid force rotates.  Sometimes this is used as the ratio of oil (fluid) whirl frequency to rotative frequency 

(approximate value). 

* Fluid Induced Instabilities  

Rotor self-excited lateral vibrations (whirl and whip) due to fluid/solid interaction in bearings, seals, and other "cylinder 

within a cylinder'' parts of a machine. 

Whirl causes the shaft dynamic motion to be forward and circular (or elliptical), and at a frequency proportional to shaft 

rotative speed.  The vibration frequency of whirl is a function of the fluid circumferential average velocity in the bearing, 

seal or rotor periphery.   Typically whirl for bearings varies from 0.3X to 0.49X (just less than one-half of shaft rotative 

speed). 

Whip occurs when whirl vibration frequency approaches a rotor system's natural frequency, most often the rotor first 

balance resonance.  The mechanism is not limited to oil lubricated bearings, but can occur when any fluid (e.g., oil, steam, 

process gas, etc.) is enclosed within a small clearance area between two body surfaces, one of which is rotating and 

dragging the enclosed fluid into circumferential rotation.  While the fluid average frequency is then usually below half 

rotative speed, changes may occur when the fluid is tangentially accelerated, for instance due to recirculation, or 

decelerated such as in anti-swirl seals. 

* Forced Vibration  

The response vibration of a mechanical system due to a forcing function (exciting force). Typically, forced vibration has 

the same frequency at that of the exciting force. 

* Free Vibration  

Vibration response of a mechanical system following an initial perturbation (change of position, velocity or force). 

Depending on the kind of perturbation, the mechanical system responds with free vibrations at one or more of its natural 

frequencies. 

* Frequency  

The repetition rate of a periodic vibration per unit of time. Vibration frequency is typically expressed in units of cycles per 

second (Hertz) or cycles per minute (to more easily relate to shaft rotative speed frequency).  In fact, since many common 

machine malfunctions produce vibration which has a fixed relationship to shaft rotative speed, vibration frequency is 

often expressed as a function of shaft rotative speed.  1X is a vibration with a frequency equal to shaft rpm, 2X vibration 

is twice shaft rpm, 0.5X is a frequency equal to one-half shaft rpm, etc. 

* Frequency Component  

The amplitude, frequency and phase characteristics of a component of a dynamic signal. 

* Frequency Response  
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The measured amplitude and phase response characteristics of a mechanical or electronic system with respect to 

frequency. 

* g 

The value of acceleration yielded by the force of earth's gravity, which varies somewhat with latitude and elevation. By 

international agreement, 9.8 m/s2 = 386 in/s2 = 32.17 ft/s2 has been chosen as the standard acceleration due to gravity. 

* Gear Mesh Frequency  

A potential vibration frequency on any machine which contains gears. It equals the number of gear teeth times shaft 

rotative speed. 

* Harmonics  

A series of vibration signal components whose frequencies are integer multiples of the fundamental, or lowest frequency, 

vibration component. 

* Harmonic Vibration  

Sinusoidal vibration with a single frequency component. 

* Heavy Spot  

A term used to describe the position of imbalance.  It is the angular location of the imbalance vector (the summation of the 

mass imbalance distribution) at a specific lateral location (in one plane) on a rotor.  See High Spot. 

* Hertz  

(Hz) Unit of frequency measurement in cycles per second. 

* High Frequency  

For purposes of studying rolling element bearings, a frequency range, typically above 5 kHz, used to measure the very 

high vibration frequencies associated with microscopic faults in bearing components. 

While this technique may provide the earliest warning of impending bearing failure for some types of bearing faults, there 

are several other machine malfunctions which can produce vibrations in this range (e.g., cavitation, rubs, etc.)   In 

addition, the high frequency measurement technique sometimes provides warnings too early, long before any 

maintenance (bearing replacement) needs to be considered. 

* High-Pass Filter  

A filter having a single transmission band extending from some finite lower corner frequency (defined as the point where 

amplitude is attenuated by 3 dB) to infinite frequency (or the upper frequency response limit of the transducer or 

instrument). 

* High Spot  

The term used to describe the response of the shaft due to imbalance force.  It is the angular location on the shaft directly 

under the vibration probe when the shaft makes its closest approach to that probe.  Also, the location on the shaft surface 

under a proximity probe when the 1X filtered vibration signal produced by the probe reaches its positive peak. 

* Hysteresis  

The difference in levels (dead band) between the trigger threshold and the reset designed to reduce false triggering. 

* Inertially Referenced  
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Motion that is referenced to a mass whose inertia keeps it stationary, yielding absolute motion.  Also describes a 

transducer with an internal inertial reference mass. 

* Influence Vector  

Used in balancing, the 1X vibration response vector due to a calibration weight, divided by the calibration weight vector at 

a particular shaft rotative speed.  The measured vibration vector divided by the unbalance force vector represents the 

rotor's transfer function.  If the description of the influence vector contains the shaft rotative speed term and the radius at 

which the calibration weight is placed on (or removed from) the rotor, the influence vector is the inverse of the 

synchronous dynamic stiffness vector.  See  Influence Vector, Direct and Influence Vector, Longitudinal. 

* Influence Vector, Direct  

An influence vector where the measured vibration vector and the unbalance force vector are at or near the same plane 

along the rotor axis. 

* Influence Vector, Longitudinal  

An influence vector where the measured vibration vector and the unbalance force vector are at different longitudinal 

planes along the rotor axis. 

* Integrator  

An electronic circuit that converts a velocity signals to a displacement signal or converts an acceleration signal to a 

velocity signal. 

* Isotropic Supports  

Rotor support systems that provide uniform dynamic stiffness in all radial/lateral directions. 

* Keyphasor Pulse  

That change in the output signal of the Keyphasor Transducer caused by the Keyphasor Event. 

* Keyphasor Transducer  

A transducer that produces a once-per-shaft-turn voltage pulse, called the Keyphasor signal.  This signal is used primarily 

to measure shaft rotative speed and as a reference for measuring vibration phase lag angle.  It is an essential element in 

measuring rotor slow roll bow/runout information.   

The Keyphasor transducer is typically a proximity probe (recommended for permanent installations in which the probe 

observes a physical gap change event), an optical pickup (used for temporary installations in which the pickup observes a 

change in reflectivity event) or a magnetic pickup.  Keyphasor is a ProvibTech registered trademark.   

* Linearity (Calibration)  

The closeness of a calibration curve to a specific straight line, expressed as the maximum deviation of any calibration 

point on a specified straight line, in any one calibration increment. 

* Load Zone  

An angular region around a rolling element bearing where there is maximum compressive force between the shaft and the 

outer race of the bearing.  Probes for bearing activity measurement (REBAM) would normally be placed in this zone for 

best (or most sensitive) measurements.  Also, the direction of steady state load on any, including fluid film, bearing. 

"Normal" load can result from the force of gravity (for horizontal machines), gear mesh forces, fluidic forces, etc. 

* Low-Pass Filter  
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A filter having a single transmission band extending from zero frequency (or the lower frequency response limit of the 

transducer or instrument) to some finite upper corner frequency (defined as the point where amplitude is attenuated by 3 

dB). 

* LVDT  

Acronym for Linear Variable Differential Transformer.  A contacting displacement transducer consisting of a movable 

core and a stationary transformer.  The core is attached to the part to be measured and the transformer is attached to a fixed 

reference.  The most common application is casing expansion measurement where the core is attached to the casing and 

the transformer (LVDT housing) is attached to the machine foundation.  Also used for valve position measurements. 

* Mechanical Runout  

A noise component in the output signal of a proximity probe transducer system; a probe gap change which does not result 

from either a shaft centerline position change or shaft dynamic motion.  Common sources include out-of-round shafts, 

scratches, chain mark, dents, rust or other conductive build-up on the shaft, stencil mark, flat spots, and engravings.  See 

Runout and Electrical Runout. 

* Micro-inch  

 A unit of length or displacement equal to 10^-6 inches or 10^-3 mils. 

* Micro-metre  

A unit of length or displacement equal to 10^-6 metres.  One micro-metre equals 0.0394 mil. Also called micron 

(obsolete). 

* Micro-Prox   

A high sensitivity ProvibTech Proximitor used to accurately and rapidly measure probe gap changes of a few 

micro-inches. 

* Mil  

A unit of length or displacement equal to 0.001 inch.  One mil equals 25.4 micrometres. 

* Mode Shape of the Rotor  

The deflected shape of a rotor at a specific rotative speed caused by an applied specific forcing function such as 

imbalance. Note, this is a three dimensional presentation of rotor lateral (See Lateral Vibration) deflection in vibration 

mode along the shaft axis. 

* Modulation, Amplitude (AM)  

The process whereby variation in the amplitude of a vibration signal results in modulation of the amplitude of a carrier 

signal.  AM is used when high frequency signal recordings are needed (i.e. gear mesh).  AM tape recorders, also called 

direct, have a finite lower frequency response above zero (dc) Hertz.  They capture dynamic data above the lower 

response frequency, but not the average shaft position data (dc voltage) which is available from a proximity probe signal. 

* Modulation, Frequency (FM)  

The process whereby variation in the amplitude of a vibration signal results in a variation a carrier frequency. FM tape 

recordings have a low frequency response down to dc (zero Hertz).  This allows recording of proximity probe dc gap 

voltages which represent average shaft position. 

* Narf  
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Acronym for Natural Axial Resonant Frequency; usually refers to axially compliant couplings. 

* Natural Frequency  

The frequency of free vibration of a system. The frequency at which a lightly damped system will oscillate upon 

momentary displacement from its steady position by a transient force. The natural frequencies of a multiple degree of 

freedom system are the frequencies of the normal modes of vibration. See  Resonance. 

* Nodal Point (Node)  

A point of minimum (or zero) shaft deflection in a specific mode shape. May readily change location along the shaft axis 

due to changes in residual imbalance or other forcing functions, or due to changes in dynamic stiffness such as increased 

bearing clearance. This is often a location of minimum shaft absolute displacement.  Vibration immediately on each side 

of the node is 180 degrees out of phase.  See  Pivotal/Conical Diagram under Mode Shape. 

* Noise  

Any component of a transducer signal which does not represent the variable intended to be measured. 

* Non-symmetric (Anisotropic) Rotor  

A rotor whose cross-section has two different geometric moments of inertia (for example, an elliptical cross-section) 

and/or the supports have different stiffness characteristics in the horizontal and vertical directions. See  Symmetric Rotor. 

* Notch Filter  

A filter which has a single rejection band extending from a finite lower cutoff frequency greater than zero to a finite upper 

cutoff frequency. Frequencies within the rejection band are eliminated or attenuated while frequencies outside the 

rejection band are retained. The opposite of a band-pass filter. 

* Nulling  

Subtraction of the shaft slow roll speed value for 1X electrical runout or mechanical runout vector component from the 

corresponding transducer signal nX vector component. 

* Nyquist Plot  

A type of graphical presentation in polar format used to evaluate the stability of an automatic control system.  This term 

should not be used to describe a similar polar presentation of machine vibration vector data. See  Polar Plot. 

* Octave  

A 2 to 1 ratio between two frequencies. An octave higher than some frequency F is 2F; an octave lower is one-half F. 

* 1X  

In a complex vibration signal, notation for the signal component that occurs at the rotative speed frequency.  Also called 

synchronous. 

* 1/2X, 1/3X, 2/5X, 4/9X, ETC.   

In a complex vibration signal, notations for signal components having frequencies equal to fractions of rotative speed. 

Also called sub-harmonic and sub-synchronous. 

* Optical Pickup  

A non-contacting transducer which emits light from an internal infrared LED, and detects the level of reflected light with 

a phototransistor. The most common application of this pickup is as a temporary Keyphasor transducer, observing a 

once-per-turn change in shaft reflectivity (dark or light paint spot or small strip of highly reflective tape on the shaft). 
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* Orbit  

The dynamic, two dimensional path of the centerline motion of a machine component, which is observed by XY 

transducers, in the plane of those transducers.  When the transducers are XY shaft proximity probes, it is the shaft 

centerline lateral vibration, called precession. Observed with an oscilloscope in the X versus Y mode. Sometimes called 

orbital motion, or Lissajous presentation. 

* Outer Race  

For rolling element bearings, a generally cylindrical component which is positioned between the rolling elements and the 

bearing housing. 

* Peak-to-Peak Value  

The difference between positive and negative extreme values of an electronic signal or dynamic motion.  See Amplitude. 

* Period  

The time required for a complete oscillation or for a single cycle of events. The reciprocal of frequency. 

* Periodic Vibration  

Oscillatory motion whose amplitude pattern repeats in time. 

* Perturbation  

Application of a forcing function to a system by means of an external device in order to study the system characteristics. 

Also called excitation. 

* Perturbation Technique  

A part of modal testing.  A method of identifying the dynamic characteristics of a mechanical system (rotors in particular) 

by comparing a known input force to the measured response. The perturbation force may be at any frequency, including 

shaft rotative frequency, (as in the case of unbalance) and zero frequency (zero speed), as in the case of a steady state load.   

The perturbation force may be applied in one direction only (unidirectional), or in two directions simultaneously, as in the 

case of a circular or elliptical force.  If the non-synchronous perturbation force is applied to the rotating shaft in two axes 

simultaneously, it may be forward (in the direction of shaft rotation) or reverse (against the direction of rotation). 

Direct perturbation of the rotating shaft by a rotating force input of known force amplitudes, phase and frequency across 

ranges of all of these, while measuring the motion response vectors of the rotor system at the same frequency, can yield 

the meaningful dynamic stiffness of a rotor system.  This methodology can be applied for identification of nonlinear, 

non-symmetric, and discontinuous systems.   

A "gong” test (impulse test) may yield some basic simple data.  A unidirectional swept sine perturbation applied to the 

support system is an improvement over the "gong" test.  Swept sine input to the rotor by a known displacement is another 

improvement, but the readout must be the response force vector which is very difficult to instrument accurately. 

* Phase Lag Angle  

The timing relationship, in degrees, between two vibration signals, or a Keyphasor pulse and a vibration signal; also, the 

phase difference between two signals such as the input force signal and output response signal. The "lag" corresponds to 

"minus" in mathematical formulations. 

* Piezoelectric  
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Any material which provides a conversion between mechanical and electrical energy. For a piezoelectric crystal, if 

mechanical stresses are applied on two opposite faces, electrical charges appear on another pair of faces. 

* Plant Summary Report  

Information available from on-line computerized monitoring systems typically representing the status of all measured 

variables, monitors, alarms, and trends for a user-defined time period (usually the previous work shift or 24 hours). 

* Polarity  

In relation to transducers, the direction of output signal change (positive or negative) caused by motion toward or away 

from the transducer in its sensitive axis.  Convention is that motion toward the transducer will produce a positive signal 

change. 

* Polar Format  

A graphical format consisting of a center reference point surrounded by concentric circles. Vector information is graphed 

on this format by plotting magnitude (vibration amplitude) as the length of a radial line, and phase (vibration phase lag 

angle) as the clock position of the line. 

* Polar Plot  

Polar format presentation of the locus of the 1X (or 2X,...) shaft vibration vector from a single channel as a function of 

shaft rotative speed.  The Polar Plot is generated by in-phase and quadrature signals, usually during machine startup or 

coast down (transient operation).  This plot is sometimes incorrectly called a Nyquist Plot. 

* Preload  

A unidirectional, radial (side) load due to external or internal mechanisms. Categorized as a "soft" or "hard" preload. A 

soft preload may shift in direction or magnitude, and can act to stabilize or destabilize the dynamic condition of the 

machine.  A hard preload is usually fixed and acts to stabilize. 

* Prime Spike  

In the study of rolling element bearings, a frequency range which encompasses, as a minimum, the primary bearing fault 

frequencies and harmonics. 

* Probe Gap  

The physical distance between the face of a proximity probe tip and the observed surface.  The distance can be expressed 

in terms of displacement mils, micrometres, or in terms of voltage (millivolts). Standard polarity convention dictates that 

a decreasing gap results in an increasing (less negative) output signal. 

* Probe  

Specifically, a proximity probe transducer, although sometimes used to describe any transducer. 

* Probe Orientation  

The angular location of a probe with respect to a polar coordinate system when viewed from the driver end of the machine. 

Typically, zero degrees are at top dead center (vertical) or at the horizontal right (3 o'clock) position on the coordinate 

system. 

* Proximitor   
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A ProvibTech signal conditioning device which sends a radio frequency signal to an eddy current proximity probe, 

demodulates the probe output, and provides output signals proportional to both the average and dynamic probe gap 

distances.  Also called an oscillator-demodulator.  Proximitor is a ProvibTech registered trademark. 

* Proximity Probe  

A non-contacting device which measures the displacement motion and position of an observed surface relative to the 

probe mounting location. Typically, proximity probes used for rotating machinery measurements operate on the eddy 

current principle and measure shaft displacement motion and position relative to the machine bearing(s) or housing.  See 

Relative Transducer. 

* Q, Filter  

Filter selectivity, i.e, the relative band of frequencies passed or rejected by the filter.  The narrower the band of 

frequencies, the higher the Q, and the broader the band, the lower the Q. This is computed by Q = fc / delta-f where fc is 

the center frequency and delta-f is the bandwidth of the filter at the 3dB points. 

* Q, Machine  

Derived from Q, Filter.  Used to describe the synchronous amplification factor of a rotor system. See  Synchronous 

Amplification Factor. 

* Radial  

A direction on a machine which is perpendicular to the shaft centerline in the XY plane; usually refers to direction of shaft 

lateral or casing motion or measurement. 

* Radial Vibration  

Shaft dynamic motion or casing vibration which is measured in a direction perpendicular to the shaft axis. 

* Raster Plot  

A type of Cascade or Waterfall plot, usually with a skewed Y axis so that the plot has an isometric appearance. 

* Real Time Analyzer  

A term used to describe an instrument which displays a vibration frequency spectrum.   

* REBAM   

An acronym for Rolling Element Bearing Activity Monitor, which is a ProvibTech method and system for monitoring and 

analyzing the performance of rolling element bearings using eddy current transducers and Micro-PROX . 

* Relative Vibration  

Vibration measured relative to a chosen reference.  Proximity probes measure shaft dynamic motion and position relative 

to the probe mounting, usually the bearing or bearing housing. 

* Relative Transducer  

A proximity probe observing shaft motion relative to the probe mounting, usually the bearing or bearing housing. 

* Repeatability 

The ability of a transducer or readout instrument to repeat measurements, under the same conditions, within narrow limits.  

Precision is the measure of repeatability. 

* Resolution  

The smallest change in applied stimulus that will produce a detectable change in the instrument output. 
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* Resonance  

The condition in which a forcing frequency coincides with a natural frequency of the system.  A resonance typically is 

identified by an amplitude peak, accompanied by a maximum rate of change of phase lag angle.  See  Balance Resonance 

Speed. 

* Rod Drop  

On a reciprocating compressor, the measurement of the position change of the piston rod relative to a fixed reference point 

as the piston drops in the cylinder due to piston rider ring deterioration.  The position measurement can indicate either the 

average position of the rod over the full stroke or the instantaneous position of the rod at a specific point in the stroke. 

* Rod Drop, Average Position  

On a reciprocating machine, the measurement of the average position change of a piston rod over the full stroke of the 

piston relative to a fixed reference on the cylinder.  This measurement is usually achieved by evaluating the average dc 

gap voltage change of a proximity probe mounted to the fixed reference. 

* Rod Drop, Instantaneous Position  

On a reciprocating machine, the measurement of the position change of a piston rod at one specific event during the full 

stroke of the piston, relative to a fixed reference of the cylinder.  This measurement is usually achieved by evaluating the 

instantaneous dc gap voltage change of a proximity probe mounted to the fixed reference.  Timing of the measurement is 

provided by a Keyphasor probe. 

* Rolling Element Bearing  

(Antifriction Bearing) A bearing which uses rolling elements (rollers or balls) to support the load of a rotating shaft and to 

minimize friction. 

* Rolloff  

The rate of attenuation of amplitude and phase with respect to frequencies above (or below) a certain point.  Thus a 

low-pass filter is designed to provide amplitude and phase rolloff at high frequencies, and a high-pass filter is designed to 

provide rolloff at low frequencies. Commonly rated in dB per octave. 

* Rolling Elements  

Components in a rolling element bearing (generally rollers or balls) which support the rotating load of a shaft. 

* ROMIS Rotating Machinery Information Systems and Services  

ProvibTech's ROMIS product offerings include on-line and periodic monitoring systems and diagnostic 

instruments/systems which provide information for operations personnel, plant engineers, and rotating machinery 

specialists including: overall values, trends, correlation of performance-related variables, steady-state dynamic data, and 

transient dynamic data.  ROMIS is applicable to transducer and monitoring systems, diagnostics and test equipment, and 

services. 

* Root Mean Square (RMS)  

Square root of the arithmetic average of a set of squared instantaneous values.  Used as a measure of amplitude; rms 

equals 0.707 x peak (sine wave only). (0.707 = 1/squareroot (2)).  See  Amplitude. 

* Rotor Position Angle  
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The angle between an arbitrary reference through the center of a bearing (typically vertical down in a horizontal machine) 

and the line connecting the bearing and shaft centers, measured in the direction of rotor rotation.  Used to indicate the 

presence of abnormal preloads on a machine, but NOT the stability of the rotor/bearing system.  See  Attitude Angle. 

* Rotor Vibration Region  

As applied to the study of rolling element bearings, using either bearing housing transducers or the ProvibTech REBAM 

system, a low-pass frequency range which includes vibration signals of the principal frequency components due to 

rotor/rolling element defects, but excludes any significant frequency components due to internal bearing defects.  

Typically, this frequency range is from one-fourth times shaft rotative speed (1/4X) to approximately three times shaft 

rotative speed. 

* RTD  

An acronym for Resistance Temperature Detector; a sensor which measures temperature and change in temperature as a 

function of resistance. 

* RUB  

Machine malfunction consisting of contact between the rotating and stationary parts of a machine involving friction, 

impacting, and changes in system stiffness. 

* Runout Compensation  

Electronic correction of a transducer output signal for the error resulting from runout.  See Nulling 

* Scale Factor  

The change in output per change in input (sensitivity) of a transducer.  Also, the factor by which a signal must be increased 

or decreased to meet the input requirements of an instrument. 

* Seismic Transducer  

Any vibration transducer which measures the absolute vibration of an object. Accelerometers and velocity transducers 

measure absolute vibration, typically of machine housing or structures, and thus are both referred to as seismic, or inertial, 

transducers. 

* Sensitivity  

The ratio of the change in the output to a change in the input. A typical sensitivity for a proximity probe transducer is 200 

millivolts per mil (7.84 volts per millimetre). 

* Shaft Average Centerline Plot  

Transient or trend plot of the shaft average radial centerline position within the bearing clearance, presented in Cartesian 

format. See  Average Shaft Position. 

* Shaft Rotative Speed  

The frequency at which a shaft is rotating at a given moment, usually expressed in units of revolutions per minute (rpm); 

may also be expressed in radians per second (mostly for laboratory work).  100 rpm equals approximately 10 radians per 

second; (100 rpm = 100 PI/30 radians per second). 

* Signal Attenuation  
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A desired reduction in amplitude of a signal without changing the frequency and phase. Also, the decrease in amplitude 

and phase that results from the transmission of vibration energy from one machine part to another (e.g., shaft to bearing 

housing). 

* Signal Conditioner  

A device placed between a signal source and a readout instrument to change the signal.  Examples: attenuators, 

preamplifiers, signal converters (for changing one electrical quantity into another, such as volts to amps or analog to 

digital), and filters. 

* Signal Gain  

The increase (or decrease) in magnitude of a signal. Also, the amount of voltage amplification utilized to enlarge small 

electronic signals up to full scale range on instruments such as FM tape recorders.  This nondimensional number is usually 

in even steps of 2, 5, and 10. 

* Signature  

Term sometimes applied to a vibration frequency spectrum which is distinctive and special to a particular machine or 

component, system or subsystem at a specific point in time, under specific machine operating conditions, etc.  Often fails 

to include the basic signal measurement of phase.  Used for historical comparison of mechanical condition over the 

operating life of the machine. 

* Slow Roll Speed  

Low rotative speed at which dynamic motion effects from such forces as imbalance are negligible. The speed at which 

shaft bow and runout can be measured. 

* Spall  

In rolling element bearings, a flake or chip of metal removed from one of the bearing races or from a rolling element.  

Spalling is evidence of serious bearing degradation and may be detected during normal bearing operation by observing 

increases in the signal amplitude of the high frequency or Prime Spike region vibration signals. 

* Spectrum  

Commonly a presentation of the amplitudes of a signal's components as a function of its frequency. 

* Spectrum Plot  

An XY plot in which the X axis represents vibration frequency and the Y axis represents vibration amplitude. 

* Stability of a Mechanical System (Liapunoff Definition, Stability "In The Small")  

A mechanical system is stable if external small perturbation of its regime will create a resultant small change of the 

previous steady state regime.  The perturbation can be introduced by applying an impulse force or changing the initial 

conditions of displacement and/or velocity.  A system is asymptotically stable if small perturbation causes a decaying 

transient response, leading to the previous steady state regime.   

Note that these definitions refer to some quantitatively undefined "small" actions.  If a mechanical system exhibits several 

steady state regimes of motion, the definitions apply equally to each one.  Note also that, according to these definitions, oil 

whirl is stable (while the rotor undergoes instability). 

* Stability of a Mechanical System (Practical Definition)  
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A mechanical system is stable if any practical perturbation results in a system response with amplitudes within acceptable, 

prescribed levels.1 

* Stability of a Rotating Machine 

A rotating machine is stable if, at operating speeds, the rotational motion of all rotating elements (shafts, disks, blades, 

etc.) and the steady equilibrium of non-rotating parts (supports, bearings, cases, foundations, etc.) are not accompanied by 

various modes of vibration with amplitudes  exceeding prescribed acceptable levels.  This definition also applies to 

machine startups and coast downs when shaft rotative speed is variable. 

* Static Data  

Data which describes the quantitative characteristics of the measured parameter. Static data can also include quantitative 

values describing the conditions under which the parameter was measured.  For predictive maintenance purposes, static 

data is typically presented in various forms of trend plot and displays/lists of current values.  Examples of static data 

include vibration amplitude, phase lag angle, frequency, average shaft position, shaft rotative speed, time, date, monitor 

alarm and OK status. 

* Steady State Data  

Data (static and/or dynamic) acquired from a machine, at constant shaft rotative speed. 

* Steady State Dynamic Data 

Dynamic data acquired under steady state machine conditions.  Typical data presentations include orbit, timebase and 

spectrum.  This data can be instantaneously trended.  See  Dynamic Data and Steady State Data. 

* Steady State Static Data  

Static data acquired under steady state machine conditions.  Example:  shaft centerline position.  See  Static Data and 

Steady State Data. 

* Strain Gauge  

A transducer which reacts to changes in strain, typically through changes in resistance. 

* Stress  

A force acting on a body (e.g., shaft) per unit area.  Usually measured in terms of lbs/in^2 or Newton/meter^2. 

* Sub-harmonic  

Sinusoidal component of a vibration signal that is a sub-multiple (integer fraction) of a fundamental frequency. 

* Sub-synchronous  

Component of a vibration signal which has a frequency less than shaft rotative speed. 

* Super-harmonic  

Sinusoidal component of a vibration signal that is an integer multiple of a fundamental frequency. 

* Super-synchronous  

Component of a vibration signal which has a frequency greater than shaft rotative speed. 

* Suppression  

The practice of using electronic circuitry to arithmetically subtract (suppress) the amplitude of an unwanted signal (noise). 

It is not recommended for vibration measurement and/or monitoring because most noise sources are vector, not scalar, 
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quantities. 

* Sweep Frequency Filter  

A type of bandpass filter which is automatically swept (tuned) through a frequency range of interest.  An instrument 

which incorporates this type of filter can be used to generate a vibration frequency spectrum.  A change in the frequency 

content of the measured signal during the time required to sweep through the frequency range will cause the spectrum to 

smear. 

* Swirl Ratio  

See  Fluid Circumferential Average Velocity Ratio. 

* Synchronous  

The component of a vibration signal that has a frequency equal to the shaft rotative frequency (1X). 

* Thermocouple  

A temperature sensing device comprised of two dissimilar metal wires which, when thermally affected (heated or cooled), 

produce a proportional change in electrical potential at the point where they join. 

* Threshold  

The level at which a trigger or other function is initiated. 

* Timebase Plot  

A presentation of the instantaneous amplitude of a signal as a function of time.  A vibration waveform can be observed on 

an oscilloscope in the time domain. 

* Torque  

A measure of the tendency of a force to cause rotation.  Equal to the force multiplied by the perpendicular distance 

between the line of action of the force and the center of rotation. 

* Torque, Average  

The constant amplitude component of the moment (force couple) applied to a rotor, in order to sustain rotational speed, 

angular acceleration or load requirements. 

* Torque, Dynamic  

The instantaneous amplitude of the time-varying component of the moment applied to a rotor, typically resulting from a 

variation in driving load or torque. 

* Torque, Static  

The force times the perpendicular distance between the force's line of action and the center of rotation (moment) as 

applied to a structure (non-rotating). 

* Torsional Vibration  

Time variation of the angle of twist, typically measured in tenths of degrees pp. 

* TorXimitorTM   

A ProvibTech non-contacting, signal conditioning device which senses strain and outputs a signal proportional to torque. 

TorXimitorTM continuously measures dynamic as well as static torque.  TorXimitorTM is a trademark of ProvibTech 

Corporation. 

* Transducer 
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A device for translating the magnitude of one quantity into another quantity.  The second quantity often has units of 

measure different from the first and serves as the source of a useful signal.  Vibration transducers convert mechanical 

motion into a proportional electronic signal (typically a voltage-proportional signal). 

* Transient Data  

Data (static and/or dynamic) acquired under transient machine conditions (startup and coast-down). 

* Transient Dynamic Data  

Dynamic data acquired under transient machine conditions.  Typical transient dynamic data presentations include Polar, 

Bode and Cascade.  See Dynamic Data and Transient Data. 

* Transient Static Data  

Static data acquired under transient machine conditions. See Static Data and Transient Data. 

* Transient Vibration  

The temporarily sustained vibration of a mechanical system. It may consist of forced or free vibration or both.  Usually 

transient vibration is associated with instantaneous changes in machine condition such as speed, load, etc. 

* Trend Data  

The periodic recording/storage of static and/or dynamic data for the purpose of observing changes as a function of time.  

Trend data is the most fundamental level of information in any predictive maintenance program. 

* Trend Interval  

The time period between consecutive data points on a Trend Plot. 

* Trend Period  

The complete time frame (beginning to end of data) of a Trend Plot 

*Trend Plot  

A presentation in Cartesian format or polar format of a plot with the measured variable versus time. 

* Trigger  

Any event which can be used as a timing reference. A trigger for an oscilloscope will initiate the sweep of the beam across 

the face of the CRT.  A trigger signal for a digital vector filter is a Keyphasor pulse which serves to align the center 

frequency of the band-pass filter to shaft rotative speed. It provides a reference from which to measure shaft rotative 

speed, 1X amplitude and phase lag angle. 

* Trip Multiplier  

That function provided in a monitor system to temporarily increase the alarm (Alert and Danger) setpoint values by a 

specific multiple (usually two or three).  This function is normally applied by manual (operator) action during startup to 

allow a machine to pass through high vibration speed ranges without monitor alarm indications. Such high vibration speed 

ranges may include system resonances and other normal transient vibrations. Also called set point multiplier. 

* TSI  

Acronym for Turbine Supervisory Instrumentation. A TSI system is a continuous monitoring system generally used on 

turbogenerator sets.  It can include such measurement parameters as shaft radial vibration, shaft absolute vibration, axial 

position, differential expansion, case expansion, valve position, eccentricity peak-to-peak, zero speed, and shaft rotative 

speed.  The system may also include a vector filter which measures vibration phase lag angle for each vibration frequency.  
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The TSI system consists of measurement transducers, monitors, interconnecting wiring and usually strip chart recorders 

or a microprocessor-based monitoring/data acquisition system. 

* 2X, 3X, ETC.   

In a complex vibration signal, notation for signal components having frequencies equal to exact multiples of shaft rotative 

speed.  Also called harmonic, super-harmonic, and super-synchronous. 

* Unbalance  

Unequal radial mass distribution on a rotor system; a shaft condition where the mass centerline (principal inertial axis) 

does not coincide with the geometric centerline. Also, the effective mass that causes rotor vibration. 

* Valve Position 

A measurement of the position of the process inlet valves on a machine, usually expressed as a percentage of the valve 

opening; zero percent is fully closed, 100 percent is fully open.  The measurement is usually made with an LVDT and is 

incorporated as part of a TSI system. 

* Vane Passing Frequencies  

A potential vibration frequency on vaned impeller compressors, pumps, and other machines with vaned rotating elements. 

It is represented by the number of vanes (on an impeller or stage) times shaft rotative speed. 

* Vector  

A quantity which has both magnitude and direction. For a vibration vector, magnitude is expressed as amplitude 

(displacement, velocity, or acceleration) and direction as phase lag angle (degrees).  For example, the 1X vibration vector 

measured at shaft operating speed, e.g., for balancing purposes, will be described as a magnitude (mils or micrometres) 

acting in a particular direction (degrees).  The vector data presentation which is easiest to interpret is the polar format.  See 

Acceptance Region and Polar Plot. 

* Vector Filter  

An electronic instrument that automatically adjusts a band-pass filter center frequency to coincide with the frequency 

determined by an external electronic input pulse (Keyphasor).  Typically, a digital vector filter is used to automatically 

filter a vibration signal at rotative speed (1X) frequency, (or 2X or other single frequency) especially under transient rotor 

speed conditions.  Among other functions, a vector filter provides the dc proportional signals (shaft centerline). 

* Velocity  

The time rate of change of displacement.  Typical units for velocity are inches/second or millimeters/second, 

zero-to-peak.  Velocity measurements are used to evaluate machine housing and other structural response characteristics.  

Electronic integration of a velocity signal yields displacement. 

* Velocity Transducer  

An electromechanical transducer, typically of inertial design, used for measuring bearing housing and other structural 

absolute vibration. Seismoprobe  is a ProvibTech registered trademark for this type of velocity transducer. 

* Velomitor® 

A piezoelectric velocity sensor with no moving parts that contains an accelerometer crystal and a built-in 

amplifier/integrator. This type of seismic sensor is used for casing vibration measurements on rotating machinery 
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equipped with rolling element bearings and frame vibration measurements on reciprocating machinery.  It measures 

absolute vibration relative to free space.  Also see Seismic Transducer. 

* Vibration 

The oscillatory (back and forth) motion of a physical object. 

* Vibration Form  

The characteristics of vibration signals which may be observed on an oscilloscope. Typical displays are timebase 

waveform and shaft Orbit. See Orbit and Waveform. 

* Waterfall Plot  

Similar to Cascade plot, except that one vertical axis is usually time instead of shaft rotative speed (rpm).  See Cascade 

Plot. 

* Waveform  

A presentation or display of the instantaneous amplitude of a signal as a function of time. A vibration waveform can be 

observed on an oscilloscope in the timebase mode. 

* Wobulator  

A mechanical device which generates dynamic motion of an observed surface at a known amplitude and frequency. The 

surface is observed by a proximity probe for the purpose of calibration of a vibration monitor.  ProvibTech's TK3-2 

incorporates a wobulator. 

* XY  

Orthogonal (perpendicular) axes in a Cartesian coordinate system.  Usually used as a reference for orthogonal (mutually 

perpendicular) radial vibration transducers.  Y represents the vertical axis and X represents the horizontal axis. 

* Zero-to-Peak Value  

One-half of the peak-to-peak value. See  Amplitude. 
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